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Preface


This document is a contract deliverable with an approval code of 3.  As such, it does not require

formal Government approval.  This document is delivered for information only, but is subject to

approval as meeting contractual requirements.


Any questions should be addressed to:


Data Management Office

The ECS Project Office

Raytheon Systems Company

1616 McCormick Dr.

Upper Marlboro, MD 20774-5301


Note: This document contains change bars to indicate the addition or revision of material since

the issuance of the predecessor document containing training material for Release 5B of the

Earth Observing System Data and Information System (EOSDIS) Core System (ECS).
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Abstract


This is Volume 9 of a series of lessons containing the training material for Release 6A of the 
Earth Observing System Data and Information System (EOSDIS) Core System (ECS). This 
lesson provides a detailed description of the process required for data distribution. 

Keywords: training, instructional design, course objective, distribution, data distribution, 
Release 6A. 
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Introduction


Identification 

Training Material Volume 9 is part of Contract Data Requirements List (CDRL) Item 129, 
whose requirements are specified in Data Item Description (DID) 625/OP3 and is a required 
deliverable under the Earth Observing System Data and Information System (EOSDIS) Core 
System (ECS), Contract (NAS5-60000). 

Scope 

Training Material Volume 9 describes the process and procedures for data distribution. This 
lesson is designed to provide the operations staff with sufficient knowledge and information to 
satisfy all lesson objectives. 

Purpose 

The purpose of this Student Guide is to provide a detailed course of instruction that forms the 
basis for understanding data distribution. Lesson objectives are developed and will be used to 
guide the flow of instruction for this lesson.  The lesson objectives will serve as the basis for 
verifying that all lesson topics are contained within this Student Guide and slide presentation 
material. 

Status and Schedule 

This lesson module provides detailed information about training for Release 6A. Subsequent 
revisions will be submitted as needed. 

Organization 

This document is organized as follows: 

Introduction:	 The Introduction presents the document identification, scope, 
purpose, and organization. 

Related Documentation:	 Related Documentation identifies parent, applicable and 
information documents associated with this document. 

Student Guide:	 The Student Guide identifies the core elements of this lesson.  All 
Lesson Objectives and associated topics are included. 

Slide Presentation:	 Slide Presentation is reserved for all slides used by the instructor 
during the presentation of this lesson. 
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Related Documentation


Parent Document 

The parent document is the document from which this ECS Training Material’s scope and 
content are derived. 

423-41-01	 Goddard Space Flight Center, EOSDIS Core System (ECS) Statement 
of Work 

Applicable Documents 

The following documents are referenced within this ECS Training Material, or are directly 
applicable, or contain policies or other directive matters that are binding upon the content of this 
document: 

420-05-03	 Goddard Space Flight Center, Earth Observing System (EOS) 
Performance Assurance Requirements for the EOSDIS Core System 
(ECS) 

423-41-02	 Goddard Space Flight Center, Functional and Performance 
Requirements Specification for the Earth Observing System Data and 
Information System (EOSDIS) Core System (ECS) 

Information Documents 

Information Documents Referenced 

The following documents are referenced herein and amplify or clarify the information presented 
in this document.  These documents are not binding on the content of the ECS Training Material. 

609-CD-600 Release 6A Operations Tools Manual for the ECS Project 

611-CD-600 Mission Operation Procedures for the ECS Project 

910-TDA-022 Custom Configuration Parameters for ECS Release 6A 

Information Documents Not Referenced 

The following documents, although not referenced herein and/or not directly applicable, do 
amplify or clarify the information presented in this document.  These documents are not binding 
on the content of the ECS Training Material. 

305-CD-600 Release 6A Segment/Design Specification for the ECS Project 

311-CD-600	 Release 6A Data Management Subsystem Database Design and 
Database Schema Specifications for the ECS Project 
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311-CD-601	 Release 6A Ingest Database Design and Database Schema 
Specifications for the ECS Project 

311-CD-602	 Release 6A Interoperability Subsystem (IOS) Database Design and 
Database Schema Specifications for the ECS Project 

311-CD-603	 Release 6A Planning and Data Processing Subsystem Database Design 
and Schema Specifications for the ECS Project 

311-CD-604	 Release 6A Science Data Server Database Design and Schema 
Specifications for the ECS Project 

311-CD-605	 Release 6A Storage Management and Data Distribution Subsystems 
Database Design and Database Schema Specifications for the ECS 
Project 

311-CD-606	 Release 6A Subscription Server Database Design and Schema 
Specifications for the ECS Project 

311-CD-607	 Release 6A Systems Management Subsystem Database Design and 
Schema Specifications for the ECS Project 

311-CD-608	 Release 6A Registry Database Design and Schema Specifications for 
the ECS Project 

313-CD-600	 Release 6A ECS Internal Interface Control Document for the ECS 
Project 

334-CD-600 6A Science System Release Plan for the ECS Project 

601-CD-001 Maintenance and Operations Management Plan for the ECS Project 

603-CD-003 ECS Operational Readiness Plan for Release 2.0 

604-CD-001 Operations Concept for the ECS Project: Part 1-- ECS Overview 

604-CD-002 Operations Concept for the ECS Project: Part 2B -- ECS Release B 

605-CD-002 Release B SDPS/CSMS Operations Scenarios for the ECS Project 

607-CD-001 ECS Maintenance and Operations Position Descriptions 

152-TP-001 ACRONYMS for the EOSDIS Core System (ECS) Project 

152-TP-003 Glossary of Terms for the EOSDIS Core System (ECS) Project 

211-TP-005	 Transition Plan 4PX to 4PY, 4PY to 5A, and 5A to 5B for the ECS 
Project 

220-TP-001 Operations Scenarios - ECS Release B.0 Impacts 

500-1002	 Goddard Space Flight Center, Network and Mission Operations 
Support (NMOS) Certification Program, 1/90 
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535-TIP-CPT-001	 Goddard Space Flight Center, Mission Operations and Data Systems 
Directorate (MO&DSD) Technical Information Program Networks 
Technical Training Facility, Contractor-Provided Training 
Specification 
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Data Distribution Overview


Lesson Overview 

This lesson will provide you with the complete process by which the ECS personnel perform 
data distribution.  The processes described in the lesson apply to Ingest/Distribution Technicians. 
The procedures involved in data distribution include such tasks as monitoring data distribution 
requests; changing the priority of a distribution request; canceling, suspending and/or resuming a 
distribution request; or unloading/loading tape stackers. 

Lesson Objectives 

Overall Objective - The overall objective of the Data Distribution lesson is for Maintenance and 
Operations (M&O) personnel to develop proficiency in the procedures that apply to data 
distribution operations for the Earth Observing System (EOS) Data and Information System 
(EOSDIS) Core System (ECS). 

Condition - The student will be given oral or written information and requirements for 
performing data distribution activities, access to the Data Server Subsystem, a copy of 
609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 
611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - The student will perform data distribution activities in accordance with the 
prescribed procedures without error. 

Specific Objective 1 - The student will describe the general functions and processes associated 
with data distribution (in the context of ECS operations). 

Condition - The student will be given written or oral questions concerning the general functions 
and processes associated with data distribution. 

Standard - The student will state without error the general functions and processes associated 
with data distribution in accordance with the lesson content and the applicable procedures. 

Specific Objective 2 - The student will perform the steps involved in launching the Data 
Distribution Operator graphical user interface (GUI) and the Storage Management Control GUI. 

Condition - The student will be given a statement of the requirements for launching the Data 
Distribution Operator and Storage Management Control GUIs, access to the Data Server 
Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A 
Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission 
Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will log in to the appropriate host using secure shell, enter the 
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command to start the Data Distribution Operator GUI in the specified mode, and enter the 
command to start the Storage Management Control GUI in the specified mode. 

Specific Objective 3 - The student will perform the steps involved in monitoring/controlling 
data distribution requests, including configuring data distribution polling, filtering data 
distribution requests, changing the priority of distribution requests, suspending/resuming 
distribution requests, and canceling distribution requests. 

Condition - The student will be given a statement of the requirements for 
monitoring/controlling data distribution requests, access to the previously launched Data 
Distribution Operator GUI in the Data Server Subsystem (through a workstation or X terminal), 
a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a 
copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will monitor/control data distribution requests (including configuring 
data distribution polling, filtering requests, and changing the status of distribution requests as 
directed) and respond to questions concerning the current status of distribution requests. 

Specific Objective 4 - The student will perform the steps involved in modifying an e-mail 
preamble applicable to data distribution. 

Condition - The student will be given a statement of the requirements for modifying an e-mail 
preamble applicable to data distribution, access to the previously launched Data Distribution 
Operator GUI in the Data Server Subsystem (through a workstation or X terminal), a copy of 
609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 
611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will select the Preamble Editor tab of the Data Distribution Operator 
GUI, select the appropriate media type, select the appropriate preamble type, edit the preamble 
text, and save the edited preamble. 

Specific Objective 5 - The student will perform the steps involved in configuring Storage 
Management polling functions. 

Condition - The student will be given a statement of the requirements for configuring Storage 
Management polling functions, access to the previously launched Storage Management Control 
GUI in the Data Server Subsystem (through a workstation or X terminal), a copy of 
609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 
611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will select the appropriate option from the pull-down menu on the 
Storage Management Control GUI, set the Operator Notification Timer and/or Cache Statistics 
Timer to the appropriate polling states as directed, enter database polling rates as directed, set 
the error retry rate as directed, and apply the modifications. 

Specific Objective 6 - The student will perform the steps involved in deleting files from cache. 
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Condition - The student will be given a statement of the requirements for deleting files from 
cache, access to the previously launched Storage Management Control GUI in the Data Server 
Subsystem (through a workstation or X terminal), a copy of 609-CD-600-001, Release 6A 
Operations Tools Manual for the ECS Project, and a copy of 611-CD-600-001, Mission 
Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will select the Cache Stats. tab on the Storage Management Control 
GUI, select the cache containing the files to be deleted, select the file(s) to be deleted from the 
cache, and mark the file(s) for deletion. 

Specific Objective 7 - The student will perform the steps involved in viewing storage 
management event log information. 

Condition - The student will be given a statement of the requirements for viewing storage 
management event log information, access to the previously launched Storage Management 
Control GUI in the Data Server Subsystem (through a workstation or X terminal), a copy of 
609-CD-600-001, Release 6A Operations Tools Manual for the ECS Project, and a copy of 
611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will select the Event Logging tab of the Storage Management Control 
GUI, enter the defining characteristic(s) of the event, search the event log for events that meet 
the specified criteria, observe event information displayed in the Event Log window, and 
respond to questions concerning the event information displayed in the Event Log window. 

Specific Objective 8 - The student will perform the steps involved in monitoring storage 
management server operations. 

Condition - The student will be given a statement of the requirements for monitoring storage 
management server operations, access to the Data Server Subsystem (through a workstation or 
X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will monitor storage management servers (including filtering requests) 
and respond to questions concerning the current status of storage management requests. 

Specific Objective 9 - The student will perform the steps involved in modifying system 
parameters in database tables. 

Condition - The student will be given a statement of the requirements for modifying system 
parameters in database tables, access to the Data Server Subsystem (through a workstation or 
X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will log in to the appropriate host using secure shell and use the 
appropriate GUI, script, or interactive structured query language (isql) commands to modify the 
value assigned to the parameter in a database table. 
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Specific Objective 10 - The student will perform the steps involved in troubleshooting data 
distribution problems. 

Condition - The student will be given a statement of the requirements for troubleshooting data 
distribution problems, access to the Data Server Subsystem (through a workstation or 
X terminal), a copy of 609-CD-600-001, Release 6A Operations Tools Manual for the ECS 
Project, and a copy of 611-CD-600-001, Mission Operation Procedures for the ECS Project. 

Standard - In accordance with the lesson content, the applicable procedure, and the statement of 
requirements the student will review the trouble symptoms, respond to requests that exceed the 
distribution request threshold (if applicable), check for an acquire failure, check appropriate log 
files (as necessary), take action to correct the problem(s), verify that distribution request 
processing has resumed, and respond to questions concerning the possible cause(s) of the 
problem. 

Importance 

This lesson applies to students who will be Distributed Active Archive Center (DAAC) 
Ingest/Distribution Technicians.  The lesson will provide them with the knowledge and skills 
needed when performing their assigned tasks.  Those tasks include the following types of 
activities: 

• Launching the Data Distribution Operator and Storage Management Control GUIs. 

• Monitoring/controlling data distribution requests. 

• Modifying packing list and e-mail preambles. 

• Configuring Storage Management polling. 

• Deleting files from cache. 

• Viewing Storage Management Event Log information. 

• Monitoring Storage Management server operations. 

• Modifying system parameters. 

• Troubleshooting Data Distribution problems. 

The lesson describes why and how the activities are performed.  Consequently, the students will 
become aware of what tasks they will be performing on the job and how to accomplish those 
tasks. 

0 625-CD-609-001




11 1

Distribution Concepts


ECS Context 

Data distribution for ECS is accomplished at the Distributed Active Archive Centers (DAACs). 
The people involved in data distribution activities are Ingest/Distribution Technicians. 

The ECS Context Diagram (Figure 1) shows the relationships among subsystems within the 
Science Data Processing component of ECS.  The Data Server Subsystem (DSS), which 
manages access to the data archive, is key to data distribution as well as several other functions. 
Of course, the context diagram shows a generalized (high-level) view of ECS. The Data 
Distribution (DDIST), Storage Management (STMGT), and Science Data Server (SDSRV) 
architecture diagrams (Figures 2 through 4 respectively) focus on the individual computer 
software configuration items (CSCIs) of the Data Server Subsystem and their relationships with 
each other and with other subsystems. 

• DDIST (Figure 2) is the part of the DSS that formats and distributes data to users. 

− Accepts requests from the SDSRV CSCI. 

− Directs the STMGT CSCI to transfer data. 

•	 STMGT (Figure 3) is the part of the DSS that stores, manages, and retrieves data 
files on behalf of other parts of the Science Data Processing components (including 
Data Distribution). 

− Provides interfaces that allow Data Distribution to obtain access to disk space. 

− Maintains a user pull area that supports electronic pull distribution. 

− Provides for the copying of files into the archive for permanent storage. 

•	 SDSRV (Figure 4) is the part of the DSS that manages and provides user access to 
collections of non-document Earth Science data. 

− Checks/verifies metadata. 

−	 Issues requests to the STMGT and DDIST CSCIs to perform storage and 
distribution services in support of the processing of service requests, such as 
insertion of data into the archive or distribution of data products from the 
archive. 
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Figure 2.  DSS Data Distribution (DDIST) CSCI Architecture 
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Figure 3.  DSS Storage Management (STMGT) CSCI Architecture
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Figure 4. DSS Science Data Server (SDSRV) CSCI Architecture 

A recent addition to ECS is the Product Distribution System (PDS), which supports the 
distribution of data on the following types of media: 

• 8mm tape cartridges. 

• Digital Linear Tape (DLT). 

• Compact disk (CD). 

•	 DVD (formerly digital video disk or digital versatile disk now referred to as just 
"DVD"). 

A description of PDS (including procedures for the distribution of data on hard media) is 
described in an addendum to this document. 
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Data Distribution (DDIST) 

The DDIST CSCI is the part of ECS Science Data Processing (SDP) that manages the 
distribution of data products to requesters, whether they are internal or external to SDP.  The 
Ingest/Distribution Technician uses DDIST when monitoring and controlling the distribution of 
data products.  The Ingest/Distribution technician has access to DDIST primarily through the 
Data Distribution Operator graphical user interface (GUI). 

DDIST has the following three major components (as shown in Figure 2): 

• Data Distribution Operator GUI (EcDsDdistGui). 

−	 GUI that allows the technician to track and manipulate distribution requests 
through GUI controls and database information. 

• Distribution Server (EcDsDistributionServer). 

−	 Server that provides the control and coordination for data distribution through 
request processing. 

• Sybase Adaptive Server Enterprise (ASE) Server. 

−	 Commercial off-the-shelf (COTS) software application that handles the request 
list and has a set of stored procedures that updates the request configuration, 
provides the request configuration to GUI operations and check-points the state 
of the CSCI for fault recovery purposes. 

Distribution personnel use the following start-up script that is available in the 
/usr/ecs/MODE/CUSTOM/utilities directory on the Distribution Server host: 

• EcDsDdistGuiStart. 

− Launches the Data Distribution Operator GUI. 

The following start-up scripts in the /usr/ecs/MODE/CUSTOM/utilities directory on the 
Distribution Server host are typically called by other applications and are not normally invoked 
directly by Distribution personnel: 

• EcDsDataDistributionAppStart. 

• EcDsDdStart. 

• EcDsDistributionServerStart. 

− Starts the Distribution Server. 

In addition to the preceding start-up scripts the following scripts are available in the 
/us/ecs/MODE/CUSTOM/utilities directory on the Distribution Server host: 

• DsDdSendMailPl.pl. 
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• EcDsDdPTEdit.pl. 

− Perl script that allows system operators to change the threshold for the number 
of threads that can be active for each priority level of distribution requests. 

Storage Management (STMGT) 

The STMGT CSCI manages all physical storage resources for all DSS components including the 
following items: 

• Tape robotic archive. 

• Random Array of Inexpensive Disks (RAID) disk cache. 

• On-line storage. 

•	 Peripheral devices (e.g., various types of magnetic tape drives) used for ingesting 
data. 

During the distribution of data, STMGT provides DDIST and SDSRV with interfaces that copy 
files out of the archive and allocate magnetic disk space for staging the files.  In addition, 
STMGT provides DDIST with interfaces that copy files for electronic distribution. 
Furthermore, STMGT maintains a user pull area that supports electronic pull distribution. 

STMGT has the following major components (as shown in Figure 3): 

• Archive Server (EcDsStArchiveServer). 

− Server that provides access to stored data. 

−	 There can be multiple archive servers running at a given site, each with its own 
type of data or storage medium. 

• Staging Servers. 

−	 Cache Manager Server (EcDsStCacheManagerServer) - Server that manages a 
group of data files that have been retrieved from the archive and placed into a 
cache area on staging disk; it maintains a list of the data files so that subsequent 
data retrieval requests are fulfilled immediately without requiring an additional 
archive access. 

−	 Pull Monitor (EcDsStPullMonitorServer) [The pull monitor is just a symbolic 
link to the Cache Manager Server binary executable image.] - Server that 
manages the files in the user pull area; deletes files as they are retrieved (i.e., 
electronically "pulled") from the user pull area by respective ECS users or as 
the files become stale (their time-out periods expire). 

−	 Staging Disk Server (EcDsStStagingDiskServer) - Server that manages shared 
disk space; it allows clients to allocate disk space and reserve files between 
staging directories and from non-staging to staging directories. 
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• Resource Managers. 

−	 8mm Server (EcDsSt8MMServer) - Server that schedules access to the 8mm 
cartridge tape drives used by Ingest; maintains a request queue based on priority 
and time of request receipt. 

−	 D3 Server (EcDsStD3Server) - Server that schedules access to the D3 cartridge 
tape drive(s); maintains a request queue. 

−	 FTP Server (EcDsStFtpServer) - Server that schedules access for Ingest or 
distribution file transfer protocol (ftp); maintains a request queue. 

• Storage Management Request Manager (EcDsStRequestManagerServer). 

− Routes requests to the appropriate server for servicing. 

−	 Provides the primary point of detection and recovery for unexpected client or 
server termination. 

• Storage Management Control GUI (EcDsStmgtGui). 

−	 GUI to the Storage Management/Data Distribution shared database; allows the 
technician to set parameters and configurations that control the STMGT servers. 

• Sybase ASE Server. 

−	 COTS software application that handles insertion and retrieval of data 
concerning storage management activities into/from the STMGT/DDIST 
database. 

• Archival Management and Storage System (AMASS). 

−	 COTS software application that supports the functioning of the data repository 
hardware (e.g., archive robotics). 

Distribution personnel use the following start-up script that is available in the 
/usr/ecs/MODE/CUSTOM/utilities directory on the Distribution Server host: 

• EcDsStmgtGuiStart. 

− Launches the Storage Management Control GUI. 

The following start-up scripts in the /usr/ecs/MODE/CUSTOM/utilities directory on the Ingest 
Server host, Access/Process Coordinators (APC) Server host, Distribution Server host, File and 
Storage Management System (FSMS) Server host, and/or Working Storage host are typically 
called by other applications and are not normally invoked directly by Distribution personnel: 

•	 EcDsStFtpServerStart. 

− Starts the ftp server. 
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•	 EcDsStStagingDiskServerStart. 

− Starts a staging disk server. 

• EcDsStStart. 

• EcDsStStorageMgmtAppStart. 

• EcEcsAppStart. 

•	 EcDsStArchiveServerStart. 

− Starts an archive server. 

•	 EcDsStCacheManagerServerStart. 

− Starts a cache manager server. 

•	 EcDsStRequestManagerServerStart. 

− Starts the Request Manager. 

•	 EcDsSt8MMServerStart. 

− Starts the 8mm Server. 

•	 EcDsStD3ServerStart. 

− Starts the D3 Server. 

•	 EcDsStDLTServerStart. 

− Starts the DLT Server. 

• EcDsStCDROMServerStart. 

− Starts the CD Server. 

In addition to the preceding applications the following scripts are available in the 
/us/ecs/MODE/CUSTOM/utilities directory on a variety of hosts, including the APC Server host, 
FSMS Server host, and/or Working Storage host: 

• EcDsCheckArchive. 

• EcDsStConfigVolGrps. 

• EcDsStDbBuild. 

• EcDsStDbDrop. 

• EcDsStDbDump. 

• EcDsStDbDumpTrans. 

• EcDsStDbLoad. 
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• EcDsStDbLoadTrans. 

• EcDsStDbPatch. 

• EcDsStFilesPerTapeUtility. 

• EcDsStVolGrpCreateMain.pl. 

Science Data Server (SDSRV) 

The SDSRV CSCI is the part of the Data Server Subsystem that issues requests to the STMGT 
and DDIST CSCIs to perform storage and distribution services in support of the processing of 
service requests, such as insertion of data into the archive or distribution of data products to 
requesters (including other ECS subsystems). 

SDSRV has the following major components (as shown in Figure 4): 

• Science Data Server (EcDsScienceDataServer). 

−	 Server responsible for managing collections of Earth Science and related data 
and for servicing requests for the storage, search, retrieval, and manipulation of 
data within those collections. 

• Hierarchical Data Format (HDF) EOS Server (EcDsHdfEosServer). 

−	 Server that provides science data subsetting capabilities for Earth Science data 
that have been configured with a subsetting service. 

• Granule Deletion Administration Tool (EcDsGranuleDelete). 

−	 Provides a command line operator interface for deleting granules either in both 
the inventory and the archive or just the archive. 

−	 The associated Production History (PH), Quality Assessment (QA) and Browse 
granules can also be deleted. 

• Science Data Server GUI (EcDsSdSrvGui). 

−	 GUI that allows the operator to monitor active EcDsScienceDataServer requests 
and receive descriptor files and dynamic link libraries (dll) for configuring 
Earth Science Data Types (ESDTs) in the EcDsScienceDataServer. 

• Autometric Spatial Query Server (SQS). 

−	 COTS software application that provides the capability to manage spatial data 
types of earth science catalog metadata (including specialized spatial searches) 
for the ECS Science Data Processing Segment (SDPS). 
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• Sybase Adaptive Server Enterprise (ASE) Server. 

−	 COTS software application that provides the management of spatial data types 
of an earth science catalog of metadata for the SDPS.  Includes capabilities for 
searching and storing the catalog. 

The following start-up script is available in the /usr/ecs/MODE/CUSTOM/utilities directory on 
the SDSRV Server host and the Operations Workstation: 

• EcDsSdSrvGuiStart. 

− Launches the Science Data Server GUI. 

In addition to the preceding applications the following scripts are available in the 
/us/ecs/MODE/CUSTOM/utilities directory on the SDSRV Server host: 

• EcTsDsClientDriverStart. 

• EcDsSrConvertEvt. 

• EcDsSrDbBuild. 

• EcDsSrDbDrop. 

• EcDsSrDbDump. 

• EcDsSrDbLoad. 

• EcDsSrDbMigrate. 

• EcDsSrDbPatch. 

• EcDsSrDbValids. 

System Changes for Release 6A 

Release 6A involves changes in the following areas: 

• Increased data processing load at certain DAACs in support of… 

−	 Reprocessing of Terra satellite data (in addition to routine processing of Terra 
data). 

⋅ Essentially doubles the previous Terra processing load. 

− Processing of data from the Aqua satellite. 

⋅	 Release 5B supported Aqua Science Software Integration and Test 
(SSI&T) only. 
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• Greater volume of data to be ingested. 

−	 Supports more interfaces and a larger number of Earth Science Data Types 
(ESDTs). 

• Higher volume of data products to be distributed. 

ECS hardware configuration upgrades for Release 6A include the following changes: 

•	 Replacement of the Fiber Distributed Data Interface (FDDI) networks with gigabit 
Ethernet networks at two DAACs [i.e., Goddard Spaceflight Center (GSFC) and 
Earth Resources Observation Systems Data Center (EDC)]. 

−	 The gigabit Ethernet networks are expected to handle the increased throughputs 
of Terra reprocessing along with routine processing for Aqua. 

•	 Addition of an SGI Origin processor to the Science Processing configuration at 
GSFC to handle the additional Aqua MODIS processing load. 

• Replacement of SGI Challenge archive machines with SGI Origin machines. 

•	 Upgrading of Science Data Server configurations (both the SDSRV and Sybase/SQS 
hosts) at EDC and GSFC so that the request load is shared between two separate host 
configurations. 

•	 Additional staging disks in the Release 6A configuration to handle increased Ingest 
and Data Distribution loads. 

The Data Distribution Process 

Data Distribution is a process of retrieving archived data and providing the data to requesters in 
response to the orders they submit.  The requesters may be classified in either of the following 
two categories: 

• External to ECS. 

−	 For example, scientists at Science Computing Facilities (SCFs) may have 
standing orders for the data products that are processed using their science 
software. 

• Internal to ECS. 

−	 For example, the Data Processing Subsystem depends on Data Distribution to 
distribute copies of archived science software and input data in support of data 
processing. 
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Data retrieved from the archives can be distributed to requesters using any of the following three 
general methods: 

• Electronic pull. 

• Electronic push. 

•	 Hard (physical) media distribution on disks or tape cartridges [distributed through the 
Product Distribution System (PDS)]. 

The method of data distribution is dictated by the nature of the data distribution request.  (The 
requester specifies the distribution method when ordering or subscribing to the data.) 

If the requester specifies distribution in the electronic “pull” mode, data are retrieved from the 
archive and placed in the “pull area” on the data server staging disk.  The requester is notified 
that the data are available for retrieval from that particular location for a set period of time.  The 
requester initiates a file transfer procedure (ftp “get”) to move the data electronically (over a 
communications network) to the requester’s own system. 

In response to a request for distribution in the electronic “push” mode, data are retrieved from 
the archive and placed on a data server staging disk. Then the retrieved data on the staging disk 
are transferred electronically (via ftp “put”) to the requester’s designated storage location 
(specified in the distribution request) under the control of the data server.  The requester is 
notified when the data push has been completed. 

If the requester submits a request for hard media distribution, the retrieved data and metadata 
files on the staging disk are transferred via ftp push to the designated PDS staging area. The 
PDS generates and mails the media; and sends an e-mail distribution notice (order shipment 
notification) in standard ECS format to the requester's e-mail address (as specified in the original 
order). 

In general, data distribution operations proceed as follows: 

• Electronic Pull: 

−	 A requester connects to the system and performs a search [e.g., using the EOS 
Data Gateway (EDG)] for a specific data product. 

−	 When the system notifies the requester that the product has been found, the 
requester submits an order for a “pull” of the data using ftp. 

−	 STMGT retrieves the data from the archive and places the data on the Data 
Server pull disk. 

− DDIST builds an e-mail notification that the requester’s order has been filled. 

−	 Message is sent via e-mail to the requester’s e-mail address, which is 
determined from the User Profile. 

−	 The requester pulls (transfers) the data from the Data Server pull disk to the 
requester’s own system. 

3 625-CD-609-001




24 2

−	 The data are deleted from the pull disk in accordance with DAAC policy 
(usually after a set period of time). 

• Electronic Push: 

−	 A requester connects to the system and performs a search for a specific data 
product. 

−	 When the system notifies the requester that the product has been found, the 
requester submits an order for an ftp push of the data.  The requester supplies 
all the necessary system, path, and security information to enable the requested 
data to be placed in a directory on the requester's system. 

−	 The data are retrieved from the archive, placed on the Data Server staging disk 
and pushed (transferred) to the requester's system. 

− DDIST builds an e-mail notification that the requester’s order has been filled. 

−	 Message is sent via e-mail to the requester’s e-mail address, which is 
determined from the User Profile. 

−	 The data are deleted from the staging disk in accordance with DAAC policy 
(e.g., after a set period of time). 

• Physical Media Distribution: 

−	 A requester connects to the system and performs a search for a specific data 
product. 

−	 The requester submits an order for a shipment of specific data on a physical 
medium. 

−	 If an order to be delivered on a physical medium is for a product other than a 
Landsat-7 product, the V0 Gateway forwards the order to the Product 
Distribution System (PDS). 

−	 For Landsat-7 products, the V0 Gateway first forwards the order to be delivered 
on a physical medium to the Distributed Ordering, Research, Reporting and 
Accounting Network (DORRAN) at the Earth Resources Observation Systems 
(EROS) Data Center (EDC); then when the gateway receives a validated 
Product Request from DORRAN, it forwards the Landsat-7 order to the PDS. 

−	 For each order it receives from the V0 Gateway, the PDS orders the requested 
data from the ECS using the Science Data Server (SDSRV) Command Line 
Interface (SCLI). 

⋅	 The PDS may break up large orders into smaller sets and may elect to 
order granules for a request individually. 

−	 ECS delivers the data to the PDS using its standard ftp push data distribution 
capability. 
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− The PDS transfers the data to the specified physical medium. 

−	 PDS e-mails a data distribution notice (order shipment notification) to the user 
and (for Landsat-7 orders) to DORRAN. 

− The PDS updates the ECS order tracking database to completed status. 
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Launching the Data Distribution Operator and Storage

Management Control GUIs


Launching the Data Distribution Operator and Storage Management 
Control GUIs 

The following software applications are associated with Data Distribution: 

• Data Distribution Operator GUI (EcDsDdistGui). 

• Distribution Server (EcDsDistributionServer). 

• Sybase ASE Server. 

In addition, Data Distribution depends on a number of related servers, especially the Science 
Data Server and Storage Management servers, to participate in the distribution of data from the 
archive. 

The following software applications are associated with Storage Management: 

• Storage Management Control GUI (EcDsStmgtGui). 

• Archive Server (EcDsStArchiveServer). 

• Cache Manager Server (EcDsStCacheManagerServer). 

• Pull Monitor (EcDsStPullMonitorServer). 

• Staging Disk Server (EcDsStStagingDiskServer). 

• 8mm Server (EcDsSt8MMServer). 

• D3 Server (EcDsStD3Server). 

• FTP Server (EcDsStFtpServer). 

• Storage Management Request Manager (EcDsStRequestManagerServer). 

• Sybase ASE Server. 

• Archival Management and Storage System (AMASS). 

The Storage Management Control GUI can be used in distribution operations to monitor cache 
(e.g., pull area) statistics. Access to the GUIs must be gained through the use of UNIX 
commands. 

Launching the Data Distribution Operator and Storage Management Control GUIs starts with the 
assumption that the applicable servers are running and the Ingest/Distribution Technician has 
logged in to the ECS system. 
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Launching the Data Distribution Operator and Storage Management Control GUIs 

NOTE: Commands in Steps 1 through 7 are typed at a UNIX system prompt. 

1 Type setenv DISPLAY clientname:0.0 then press the Return/Enter key. 

•• Use either the X terminal/workstation IP address or the machine-name for the 
clientname. 

•• When using secure shell, the DISPLAY variable is set just once, before logging in to 
remote hosts.  If it were to be reset after logging in to a remote host, the security 
features would be compromised. 

2	 Start the log-in to the Distribution Server host by typing /tools/bin/ssh hostname (e.g., 
e0dis02, g0dis02, l0dis02, or n0dis02) in the new window then press the Return/Enter 
key. 

•• If you receive the message, Host key not found from the list of known hosts.  Are 
you sure you want to continue connecting (yes/no)?  type yes (“y” alone will not 
work). 

•• If you have previously set up a secure shell passphrase and executed sshremote, a 
prompt to Enter passphrase for RSA key '<user@localhost>' appears; continue 
with Step 3. 

• If you have not previously set up a secure shell passphrase; go to Step 4. 

3	 If a prompt to Enter passphrase for RSA key '<user@localhost>' appears, type your 
Passphrase then press the Return/Enter key. 

• Go to Step 5. 

4	 At the <user@remotehost>’s password: prompt type your Password then press the 
Return/Enter key. 

5 Type cd  /usr/ecs/MODE/CUSTOM/utilities then press Return/Enter. 

•• Change directory to the directory containing the Data Distribution Operator GUI and 
Storage Management Control GUI start-up scripts (e.g., EcDsDdistGuiStart, 
EcDsStmgtGuiStart). 

• The MODE will most likely be one of the following operating modes: 

− OPS (for normal operation). 

− TS1 (for SSI&T). 

− TS2 (new version checkout). 

•• Note that the separate subdirectories under /usr/ecs apply to different operating 
modes. 
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6 Type EcDsDdistGuiStart MODE  then press Return/Enter. 

•• The Data Distribution Operator GUI Distrib’n Requests tab (Figure 5) is 
displayed. 

7 Type EcDsStmgtGuiStart MODE  then press Return/Enter. 

•• The Storage Management Control GUI Storage Config. tab (Figure 6) is 
displayed. 
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Figure 5.  Distrib’n Requests Tab (Data Distribution Operator GUI) 
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Figure 6.  Storage Config. Tab (Storage Management Control GUI) 
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Monitoring/Controlling Distribution Requests


Monitoring/Controlling Data Distribution Requests 

Data Distribution activities are monitored and controlled using the Data Distribution Operator 
GUI and the Storage Management Control GUI.  The Data Distribution Operator GUI has 
the following five tabs: 

• Distrib’n Requests [for monitoring/controlling distribution requests]. 

• System Requests [not currently functional]. 

• Hard Media [obsolete]. 

• Preamble Editor [for editing packing lists and other messages to requesters]. 

• Event Logging [not currently functional]. 

The Storage Management Control GUI has the following six tabs: 

• Storage Config. [for configuring Storage Management components]. 

• Vol Grp Config. [for configuring archive volume groups]. 

• Resource Mngmnt. [for monitoring/controlling media resources]. 

• Cache Stats. [for monitoring/controlling the contents of various caches]. 

• Storage Events [for searching for events in the Event Log]. 

• Request Status [for displaying the status of requests in Storage Management]. 

The Ingest/Distribution Technician monitors and manages data distribution requests primarily 
via the Data Distribution - Track Activity window of the Distrib’n Requests tab (Figure 5) on 
the Data Distribution Operator GUI. From the Data Distribution - Track Activity window 
the DAAC Ingest/Distribution Technician can perform the following functions: 

• View data distribution requests. 

• Change the priority of a selected distribution request. 

• Cancel or suspend a request. 

• Resume processing of a suspended request. 

• Filter on all or specific requests by... 

− Request ID. 

− Requester. 
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− All Requests. 

− Media Type. 

− State (current status). 

The Data Distribution - Track Activity window displays the following information for each 
data distribution request: 

•• Mod [contains a check mark if the request has been selected/modified (e.g., 
suspended) by the operator during the current session]. 

• Request ID. 

• Requester. 

• Esdt Type. 

• Media [type]. 

• Priority. 

• State [current state of the request]. 

•• Status Mnemonic [message indicating there is an operator message attached to the 
request]. 

• Submission Time [(and date) GMT]. 

• End Time [(and date) GMT]. 

• Total Size [of the request] (bytes). 

• Media # Completed. 

• # of Media. 

• # of Granule. 

• # of Files. 

• Order ID. 

• Ordered State [the next state that the request should have (based on operator input)]. 

The procedure for monitoring data distribution requests starts with the assumption that all 
applicable servers and the Data Distribution Operator GUI are currently running and the 
Distrib’n Requests screen (Figure 5) is being displayed. 

Monitoring/Controlling Data Distribution Requests 

1� Configure polling as described in the procedure for Configuring Data Distribution 
Polling (subsequent section of this lesson). 
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2� Observe information displayed on the Distrib’n Requests tab of the Data Distribution 
Operator GUI. 

•• By default all current distribution requests are shown in the Data Distribution 
Requests list of the Data Distribution - Track Activity window (Distrib’n 
Requests tab). 

•• Note that virtually all data retrieved from the archive is controlled by Data 
Distribution; consequently there may be a lot of activity on the Data Distribution -
Track Activity screen, especially if data processing is operating at or near capacity. 

− Consequently, it may be useful to restrict the number of distribution requests 
displayed by filtering them as described in the next step of this procedure. 

•• Horizontal and vertical scroll bars allow viewing data that are not readily visible in 
the window. 

• The Refresh button provides a means of updating the data on the screen. 

•• The Find button provides a means of performing a keyword search of the distribution 
requests. 

•• The Operator Messages field at the bottom of the GUI displays messages 
concerning events occurring in distribution operations. 

•• Selecting Options → Verify Connection from the pull-down menu allows the 
operator to check the status of the connection to the server. 

−• The status is displayed in the Operator Messages field at the bottom of the 
GUI. 

•• Selecting Options → Reconnect from the pull-down menu allows the operator to 
re-establish a connection with the server. 

−• The status is displayed in the Operator Messages field at the bottom of the 
GUI. 

•• Highlighting a distribution request in the Data Distribution - Track Activity 
window then selecting View→ Detailed from the pull-down menu allows the 
operator access to more detailed information concerning the status of the distribution 
request. 

−• The information is displayed in the Operator Messages field at the bottom of 
the GUI. 

3� If the list of data distribution requests shown in the Data Distribution - Track Activity 
window needs to be filtered, perform the procedure for Filtering Data Distribution 
Requests (subsequent section of this lesson). 

4 Observe data distribution requests displayed in the Data Distribution Requests list. 
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5� If it becomes necessary to change the priority of a data distribution request, perform the 
procedure for Changing the Priority of Data Distribution Requests (subsequent 
section of this lesson). 

6� If it becomes necessary to either suspend a data distribution request or resume processing 
of a suspended request, perform the procedure for Suspending/Resuming Data 
Distribution Requests (subsequent section of this lesson). 

7� If it becomes necessary to cancel a data distribution request, perform the procedure for 
Canceling Data Distribution Requests (subsequent section of this lesson). 

8 Repeat Steps 3 through 7 as necessary to monitor data distribution requests. 

9� If it becomes necessary to exit from the Data Distribution Operator GUI select 
File → Exit from the pull-down menu. 

Configuring Data Distribution Polling 

The Data Distribution Operator GUI Options menu provides the Ingest/Distribution 
Technician with a means of switching the Data Distribution database polling function on or off. 
In addition, there are two parameters that the technician can modify: 

• DDist Polling Rate 

−• How often (in seconds) the system updates the information displayed in the 
Data Distribution - Track Activity window. 

• Error Retry Rate 

−• Amount of time (in seconds) that the system waits before trying to poll the Data 
Server after a failed attempt. 

The procedure for configuring data distribution polling starts with the assumption that all 
applicable servers and the Data Distribution Operator GUI are currently running and the Data 
Distribution - Track Activity window (Figure 5) on the Distrib’n Requests tab is being 
displayed. 

Configuring Data Distribution Polling 

1 Select Options → System Settings from the pull-down menu. 

• The Refresh Options dialogue box (Figure 7) is displayed. 

2� To change the DDist Polling state (from off to on or vice versa), click on the 
DDist Polling On button. 

• If the button does not have a check mark in it, clicking on it turns DDist Polling on. 
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Figure 7.  Refresh Options Dialogue Box 

• If the button already has a check mark in it, clicking on it turns DDist Polling off. 

3� To change the polling rate type the desired value (in seconds) in the DDist Polling Rate 
field. 

• The default value is 30 seconds. 

4� To specify an error retry rate, type the desired value (in seconds) in the Error Retry 
Rate field. 

5� When the appropriate data have been entered in the Refresh Options dialogue box 
fields, click on the appropriate button. 

• Ok - to apply the selections and dismiss the Refresh Options dialogue box. 

•• Cancel - to dismiss the Refresh Options dialogue box without applying the 
selections. 

6 Return to the procedure for Monitoring/Controlling Data Distribution Requests. 

Filtering Data Distribution Requests 

The distribution requests to be displayed in the Data Distribution Requests list (Data 
Distribution - Track Activity window shown in Figure 5) can be filtered using the 
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Distribution Filter Requests dialogue box.  The filtering can be done on the basis of the 
following criteria, either individually or in combination: 

• Request ID. 

• Requester. 

• Media Type. 

• State [of the request]. 

The procedure for filtering data distribution requests starts with the assumption that all 
applicable servers and the Data Distribution Operator GUI are currently running and the Data 
Distribution - Track Activity window (Figure 5) on the Distrib’n Requests tab is being 
displayed. 

Filtering Data Distribution Requests 

1 Select View → Filter from the pull-down menu. 

• The Distribution Filter Requests dialogue box (Figure 8) is displayed. 

•• Perform as many of the following steps as necessary depending on the criteria for 
filtering distribution requests: 

− Request ID - Step 2. 

− Requester - Step 3. 

− All Requests - Step 4. 

− Media Type - Step 5. 

− State - Step 6. 

2� If a specific distribution request is desired and the request ID is known, first click on the 
Request ID radio button, then click in the adjacent text box and type the request ID. 

3� If data distribution requests submitted by a particular requester are desired, first click on 
the Requester radio button, then click in the adjacent text box and type the requester’s 
identification. 

•• In the text box the requester must be identified exactly as known to the Data Server 
Subsystem. 

4� If all data distribution requests are to be displayed in the Data Distribution Requests 
list, click on the All Requests radio button and go to Step 7. 

•• The All Requests button is particularly useful for restoring the Data Distribution 
Requests list after reviewing a previously filtered set of requests. 
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Figure 8.  Distribution Filter Requests Dialogue Box 
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5� If a list of data distribution requests filtered by media type(s) is needed, click on the 
applicable button(s) in the Media Type section of the Filter Requests dialogue box. 

• Radio buttons corresponding to the following types of media are available: 

−• CD-ROM  [(Compact Disk – Read-Only Memory (not relevant in 
Release 6A)]. 

− DLT [Digital Linear Tape (not relevant in Release 6A)]. 

− 8 mm (tape) (not relevant in Release 6A). 

− D3 (not relevant in Release 6A). 

− Electronic Push. 

− Electronic Pull. 

• In addition, the following media selections are available: 

− All. 

− None. 

•• If other filters (e.g., requester or state) are to be applied, the Apply button may be 
clicked to implement the media type filter and leave the Filter Requests dialogue 
box open. 

6� If a list of data distribution requests filtered by state(s) is needed, click on the applicable 
button(s) in the State section of the Filter Requests dialogue box. 

• Radio buttons corresponding to the following states are available: 

− Pending. 

− Active. 

− Staging. 

− Transferring. 

− Cancelled. 

− Suspended. 

− Suspended with Errors. 

− Waiting for Shipment. 

− Shipped. 

− Failed. 

• In addition, the following state selections are available: 

− All. 
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− None. 

•• If other filters (e.g., requester or media type) are to be applied, the Apply button may 
be clicked to implement the state filter and leave the Filter Requests dialogue box 
open. 

7 When all filter criteria have been selected, click on the appropriate button: 

•• OK - to implement the selections and dismiss the Distribution Filter Requests 
dialogue box. 

−• The Data Distribution - Track Activity window (Figure 5) reappears; only 
requests that meet the specified filter criteria appear in the list. 

•• Apply - to implement the selections without dismissing the Distribution Filter 
Requests dialogue box. 

− The Distribution Filter Requests dialogue box remains open. 

•• Cancel - to dismiss the Distribution Filter Requests dialogue box without 
implementing the selections. 

−• The previously available Data Distribution Requests list is shown in the Data 
Distribution - Track Activity window (Figure 5). 

8 Return to the procedure for Monitoring/Controlling Data Distribution Requests. 

Changing the Priority of Data Distribution Requests 

The Change Priority area of the Data Distribution - Track Activity window (Figure 5) allows 
the Ingest/Distribution Technician to change the priority of data distribution requests.  The 
procedure for changing the priority of data distribution requests starts with the assumption that 
all applicable servers and the Data Distribution Operator GUI are currently running and the 
Data Distribution - Track Activity window (Figure 5) on the Distrib’n Requests tab is being 
displayed. 

Changing the Priority of Data Distribution Requests 

1� If the list of data distribution requests shown in the Data Distribution - Track Activity 
window needs to be filtered to include the distribution request for which the priority is to 
be changed, perform the procedure for Filtering Data Distribution Requests. 

2� Highlight the distribution request to be assigned a different priority by clicking on its 
entry in the Data Distribution Requests list. 
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3� Click and hold the Change Priority option button to display a menu of priorities, move 
the mouse cursor to the desired selection (highlighting it), then release the mouse button. 

• The following priority codes are available: 

− Xpress. 

− Vhigh. 

− High. 

− Normal. 

− Low. 

•• Selected code is displayed on the Change Priority option button when the mouse 
button is released. 

4� To implement the priority change click on the Apply button to the right of the priority 
option button. 

5 Click on the Refresh button to update the data displayed on the screen. 

•• Priority of the request, as displayed in the Priority column of the Data Distribution 
Requests list, changes from its original value to the newly selected priority. 

•• A check mark is displayed in the Mod column of the Data Distribution Requests 
list to indicate that the request has been changed. 

6� Repeat the preceding steps as necessary to change the priority of additional data 
distribution requests. 

7 Return to the procedure for Monitoring/Controlling Data Distribution Requests. 

Suspending/Resuming Data Distribution Requests 

Under certain circumstances it may be advisable to suspend the processing of a data distribution 
request and resume it at a later time.  For example, if there is a very large request that is taking 
up resources and causing other requests to back up waiting (especially requests from data 
processing that must be filled to allow processing to proceed), the processing of that request 
should be suspended until a time when there is less demand on data distribution. 

Use the procedure that follows to suspend and subsequently resume data distribution.  The 
procedure starts with the assumption that all applicable servers and the Data Distribution 
Operator GUI are currently running and the Data Distribution - Track Activity window 
(Figure 5) on the Distrib’n Requests tab is being displayed. 
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Suspending/Resuming Data Distribution Requests 

1� If the list of data distribution requests shown in the Data Distribution - Track Activity 
window needs to be filtered to include the distribution request to be suspended or 
resumed, perform the procedure for Filtering Data Distribution Requests. 

2� To suspend requests, perform Steps 3 through 6; to resume suspended requests, go to 
Step 7. 

3� If all new requests displayed in the Data Distribution Requests list are to be suspended, 
click on the Suspend New Requests button. 

• The data distribution requests are suspended. 

• Go to Step 5. 

4� If a single request displayed in the Data Distribution Requests list is to be suspended, 
first click on the corresponding row in the Data Distribution Requests list to highlight 
the request, then click on the Suspend button. 

• The selected data distribution request is suspended. 

5 Click on the Refresh button to update the data displayed on the screen. 

•• Status of request(s), as displayed in the State column of the Data Distribution 
Requests list, change(s) from original value to “Suspended.” 

•• Check mark(s) is (are) displayed in the Mod column of the Data Distribution 
Requests list to indicate that changes have been made to the request(s). 

6� If there are no suspended requests to be resumed at this time, return to the procedure for 
Monitoring/Controlling Data Distribution Requests. 

7� If processing of all new requests displayed in the Data Distribution Requests list is to 
be resumed, click on the Resume New Requests button. 

• The data distribution requests resume processing. 

• Go to Step 9. 

8� If processing of a single request displayed in the Data Distribution Requests list is to be 
resumed, first click on the corresponding row in the Data Distribution Requests list to 
highlight the request, then click on the Resume button. 

• The selected data distribution request resumes processing. 

9 Click on the Refresh button to update the data displayed on the screen. 

•• Status of request(s), as displayed in the State column of the Data Distribution 
Requests list, changes from “Suspended” to whatever state(s) is (are) appropriate for 
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the continuation of request processing (depending on each request’s status when it 
was suspended). 

•• Check mark(s) is (are) displayed in the Mod column of the Data Distribution 
Requests list to indicate that changes have been made to the request(s). 

10 Return to the procedure for Monitoring/Controlling Data Distribution Requests. 

Canceling Data Distribution Requests 

Sometimes it may be necessary to cancel the processing of a data distribution request. The 
procedure for canceling data distribution request processing starts with the assumption that all 
applicable servers and the Data Distribution Operator GUI are currently running and the Data 
Distribution - Track Activity window (Figure 5) on the Distrib’n Requests tab is being 
displayed. 

Canceling Data Distribution Requests 

1� If the list of data distribution requests shown on the Data Distribution - Track Activity 
window needs to be filtered to include the distribution request to be canceled, perform 
the procedure for Filtering Data Distribution Requests. 

2� To cancel a request first click on the corresponding row in the Data Distribution 
Requests list to highlight the desired request. 

3 Click on the Cancel button near the bottom of the Distrib’n Requests tab. 

• The selected data distribution request is canceled. 

4 Click on the Refresh button to update the data displayed on the screen. 

•• Status of the request, as displayed in the State column of the Data Distribution 
Requests list, changes from its original value to “Canceled.” 

•• A check mark is displayed in the Mod column of the Data Distribution Requests 
list to indicate that the request has been changed. 

5 Return to the procedure for Monitoring/Controlling Data Distribution Requests. 
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Modifying Preambles


Modifying Preambles 

The Preamble Editor tab (Figure 9) on the Data Distribution Operator GUI allows the 
Ingest/Distribution Technician to review and/or modify the text of preambles to the following 
types of documents: 

• Packing list. 

• Successful e-mail. 

• Failed e-mail. 

The preambles are accessible in the /usr/ecs/MODE/CUSTOM/data/DSS directory on the 
Distribution Server host.  Figure 10 is a sample of the “ftp push failed e-mail” preamble file 
(EcDsDdFtpPushEMFailurePreamble.txt).  The directory contains preambles for the different 
types of distribution.  The following two types of distribution only are relevant for Release 6A: 

• Ftp pull. 

• Ftp push. 

The procedure for modifying preambles starts with the assumption that all applicable servers and 
the Data Distribution Operator GUI are currently running and the Data Distribution - Track 
Activity window (Figure 5) on the Distrib’n Requests tab is being displayed. 

Modifying Preambles 

1 Click on the Data Distribution Operator GUI Preamble Editor tab. 

• The Preamble Editor screen (Figure 9) is displayed. 

2� Click and hold the Media Type option button to display a menu of types of distribution 
media, move the mouse cursor to the desired selection (highlighting it), then release the 
mouse button. 

• The following media types are listed: 

− 8mm. 

− D3. 

− FtpPush. 

− FtpPull. 
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Figure 9.  Preamble Editor Tab (Data Distribution Operator GUI) 
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Figure 10.  Sample FTP Push Failed E-Mail Preamble 
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− CDROM. 

− DLT. 

• The selected media type is displayed on the Media Type option button. 

3	 Click and hold the Preamble Type option button to display a menu of types of 
preambles, move the mouse cursor to the desired selection (highlighting it), then release 
the mouse button. 

• The following preamble types are listed: 

− Packing List. 

− Successful Email. 

− Failed Email. 

• The selected preamble type is displayed on the Preamble Type option button. 

• The selected preamble is displayed in the Preamble Text window. 

−• If the Preamble Text window is blank, either there is no current preamble of 
the specified type or the preamble file is empty.  Proceed to Step 4 and create a 
new preamble. 

4	 Click in the Preamble Text window and type modifications to the preamble text as 
necessary. 

•• The following editing functions are available from the Edit pull-down menu or by 
clicking on the right mouse button: 

− Cut. 

− Copy. 

− Paste. 

5 Click on the appropriate button from the following selections: 

• Save - to save the preamble text as modified. 

• Reset - to discard any changes and revert to the original (unmodified) preamble text. 

• Clear - to remove all text from the Preamble Text window. 

−• When the Clear button has been selected, a Preamble Save Confirmation 
Dialogue Box (Figure 11) is displayed. 

6	 If the Preamble Save Confirmation Dialogue Box is displayed, click on the appropriate 
button from the following selections: 

• Yes - to save the preamble text as modified. 

• No - to revert to the original (unmodified) preamble text. 
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Figure 11. Preamble Save Confirmation Dialogue Box 
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Performing Hard (Physical) Media Operations


Media Operations 

Media operations are accomplished through the Product Distribution System (PDS), which is 
described in an addendum to this document. 
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Configuring Storage Management Polling and

Deleting Files from Cache


Configuring Storage Management Polling 

The Storage Management Control GUI Options menu provides the Ingest/Distribution 
Technician with a means of switching the following two database polling functions on or off: 

• Operator Notification Timer [e.g., polling for displaying Event Log data]. 

• Cache Statistics Timer [polling for displaying cache statistics data]. 

In addition, the technician can modify the following parameters relevant to the Operator 
Notification Timer: 

• Database Polling Rate. 

−• How often (in seconds) the system updates the information displayed on the 
GUI. 

• Error Retry Rate. 

−• Amount of time (in seconds) that the system waits before trying to poll the 
database server after a failed attempt. 

The technician can modify the following parameter relevant to the Cache Statistics Timer: 

• Database Polling Rate. 

The procedure for configuring storage management polling starts with the assumption that all 
applicable servers and the Storage Management Control GUI are currently running and the 
Storage Config. tab (Figure 6) is being displayed. 

Configuring Storage Management Polling 

1 Select Options → System Settings from the pull-down menu. 

• The Session Settings dialogue box (Figure 12) is displayed. 

2	 To change either the Operator Notification Timer or Cache Statistics Timer Polling 
state (from off to on or vice versa), click on the corresponding Polling button. 

•• If OFF is displayed in the Polling field , clicking on the adjacent button turns Polling 
on. 

•• If ON is displayed in the Polling field , clicking on the adjacent button turns Polling 
off. 
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Figure 12. Session Settings Dialogue Box 

3	 To change the database polling rate for either the Operator Notification Timer or 
Cache Statistics Timer type the desired value (in seconds) in the corresponding 
Database Polling Rate field. 

• The default value is 30 seconds. 

4	 To change the error retry rate for the Operator Notification Timer, type the desired 
value (in seconds) in the Error Retry Rate field. 

5	 When the appropriate data have been entered in the Session Settings dialogue box fields, 
click on the appropriate button. 

• Ok - to apply the selections and dismiss the Session Settings dialogue box. 

• Apply - to apply the selections without dismissing the Session Settings dialogue box. 

•• Cancel - to dismiss the Session Settings dialogue box without applying the 
selections. 
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Deleting Files from Cache 

The Storage Management Control GUI’s Cache Stats. tab displays all of the files that are in 
the cache areas, including the Pull Monitor and other staging areas.  The data displayed on the 
Cache Stats. tab reports general statistics on the selected cache and allows the operator to delete 
expired files in cache areas. If a cache area reaches an operator-configurable threshold, the 
operator receives a warning message in the operator messages area of the GUI.  If expired files 
are not deleted and the cache fills completely, the server is not able to copy new files to the 
cache area. 

The procedure for deleting files from cache starts with the assumption that all applicable servers 
and the Storage Management Control GUI are currently running and the Storage Config. tab 
(Figure 6) is being displayed. 

Deleting Files from Cache 

1 Click on the Storage Management Control GUI Cache Stats. tab. 

• The Cache Stats. tab (Figure 13) is displayed. 

2	 To view the contents of a particular cache (e.g., Pull Monitor cache 1) click and hold on 
the option button to the right of the Cache Id field, move the mouse cursor to the desired 
selection (highlighting it), then release the mouse button. 

• The selected cache is displayed in the Cache Id field of the Cache Stats. tab. 

• The following cache statistics are displayed in the Cache Statistics area: 

− Current Utilization. 

− Used Space (Blocks). 

− Free Space (Blocks). 

− Total Space (Blocks). 

− Number of Resident Files. 

− Maximum File Size (Blocks). 

− Minimum File Size (Blocks). 

− Average File Size (Blocks). 

•• The following information concerning the files in the selected cache is listed in the 
Cache Information window: 

− Filename. 

− File Size. 

− Last Accessed. 
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Figure 13.  Storage Management Control GUI’s Cache Stats. Tab 
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− Delete Flag (displays either blank space or DELETE). 

− State. 

3 Observe cache statistics information displayed on the Cache Stats. tab. 

4� Click on the row corresponding to a file to be deleted in the Cache Information window 
of the Cache Stats. tab. 

• Multiple rows may be selected. 

5 Click on the Mark Delete button near the bottom of the Cache Stats. tab. 

• Y is displayed in the Del. Flag field for the row in the Cache Information window. 

6� If any file that should be left in the cache has been inadvertently marked Delete, first 
click on the row corresponding to the file then click on the Unmark Delete button near 
the bottom of the Cache Stats. tab. 

• N is displayed in the Del. Flag field for the row in the Cache Information window. 

7� If it becomes necessary to exit from the Storage Management Control GUI select 
File → Exit from the pull-down menu. 

Viewing Storage Management Event Log Information 

The Storage Events tab (Storage Management Control GUI) provides the Ingest/Distribution 
Technician with the ability to search the Event Log and obtain reports on events that have 
occurred in Storage Management.  It is possible to review the following information concerning 
any particular Storage Management event: 

• Number. 

• Date. 

• Level. 

• Type. 

• Message. 

The following search criteria can be used individually or in combination to view entries in the 
Event Log: 

• Date Interval. 

• Event Type. 

• Event Level. 

• Message. 

7 625-CD-609-001




58 5

The procedure for viewing Storage Management Event Log information starts with the 
assumption that all applicable servers and the Storage Management Control GUI are currently 
running and the Storage Config. tab (Figure 6) is being displayed. 

Viewing Storage Management Event Log Information 

1 Click on the Storage Management Control GUI Storage Events tab. 

• The Storage Events screen (Figure 14) is displayed. 

• If Event Log entries are to be displayed on the basis of a particular…. 

−• Time period, perform Step 2.  (If no time period is specified, log entries for the 
current day will be displayed.) 

− Event type, perform Step 3. 

− Event level, perform Step 4. 

− Message, perform Step 5. 

•• Any of the preceding criteria (time period, event type, event level, or message) may 
be used individually or in combination to view entries in the Event Log. 

2� To view Event Log entries for a particular time period, click in the appropriate Date 
Interval: Begin, and/or Date Interval: End field, and type the appropriate numerical 
values in MM/DD/YYYY format. 

• The Tab key may be pressed to move from field to field. 

•• Another method of changing date settings (other than typing the numbers) is to click 
in each of the date fields in turn and click on the up/down buttons adjacent to the 
Date Interval fields until the correct date is indicated. 

3� To view log entries for a particular event type, click and hold on the Event Type option 
button, move the mouse cursor to the desired selection (highlighting it), then release the 
mouse button. 

• The selected event type is displayed on the Event Type option button. 

• The following event types are displayed on the Event Type option button: 

− Any. 

− Device. 

− Cache. 

− Software. 

− COTS. 
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Figure 14. Storage Events Screen 
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− Sybase. 

− Pulldisk. 

− Unknown. 

4� To view log entries for a particular event level, click and hold on the Event Level option 
button, move the mouse cursor to the desired selection (highlighting it), then release the 
mouse button. 

• The selected event level is displayed on the Event Level option button. 

• The following event levels are displayed on the Event Level option button: 

− Any. 

− Information. 

− Warning. 

− Error. 

− Severe. 

− Fatal. 

− Unknown. 

5� To view log entries for a particular message type the relevant message in the Message 
field. 

6� Click on the Search button to search the event log for events that meet the specified 
criteria. 

•• The search results are displayed in the Event Log window of the Storage 
Management Control GUI Storage Events tab (Figure 14). 

7 Observe event information displayed in the Event Log window. 

8� To clear entries in the Event Log Search Parameter fields, click on the Clear 
Parameters button. 

• Entries in the Event Log Search Parameter fields are cleared. 

9� To purge entries from the Event Log, first click on the row corresponding to the event to 
be deleted in the Event Log window then click on the Purge Selected button. 

• Multiple entries may be selected. 

• Selected entries are deleted from the Event Log. 

10 If a new Event Log search is to be performed on the basis of a particular…. 

• time period, return to Step 2. 
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• event type, return to Step 3. 

• event level, return to Step 4. 

• message, return to Step 5. 

11� If it becomes necessary to exit from the Storage Management Control GUI select 
File → Exit from the pull-down menu. 
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Monitoring Storage Management Server Operations


Request Status 

The Request Status tab (Figure 15) on the Storage Management Control GUI provides the 
Ingest/Distribution Technician with the ability to monitor processing activity in all of the storage 
management servers for a given mode. The Request Status Information table lists the requests 
that are currently being serviced by storage management servers and those that have been 
completed within the last 24 hours.  It is possible to review the following information 
concerning any particular storage management request: 

• Operation [type of operation represented by the request]. 

• Request ID. 

•	 Progress [stage of processing on which the request is currently working (may include 
a numeric progress indication)]. 

• Status. 

• Priority. 

•	 When Submitted [time and date when the request was received by the Storage 
Management server that is responsible for the request]. 

• Last Updated [time and date when the status was last updated for the request]. 

Using the Request Status tab the Ingest/Distribution Technician can detect stalled requests or 
servers that appear to be idle. 

The procedure for monitoring storage management server operations starts with the assumption 
that all applicable servers and the Storage Management Control GUI are currently running and 
the Storage Config. tab (Figure 6) is being displayed. 

Monitoring Storage Management Server Operations 

1 Click on the Storage Management Control GUI Request Status tab. 

• The Request Status tab (Figure 15) is displayed. 

2	 Observe information displayed on the Request Status tab of the Storage Management 
Control GUI. 

•	 The Request Status Information table displays the following information: 

− Operation. 
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Figure 15.  Request Status Tab (Storage Management Control GUI) 
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− Request ID. 

− Progress. 

− Status. 

− Priority. 

− When Submitted. 

− Last Updated. 

•� By default all storage management server requests for the last 24 hours are shown in 
the Request Status Information table of the Request Status tab. 

•� Note that virtually all data inserted into or retrieved from the archive is controlled by 
storage management servers; consequently there may be a lot of activity on the 
Request Status tab. 

−� Consequently, it may be useful to restrict the number of requests displayed by 
filtering them as described in the next step of this procedure. 

•� Clicking on any of the column headers of the Request Status Information table 
causes the listed requests to be sorted in order by the column selected. 

−� For example, clicking on the Last Updated column header causes the requests 
to be listed in order from the least recently updated to the most recently 
updated. 

•� The Operator Messages field at the bottom of the GUI displays messages 
concerning events occurring in storage management operations. 

If the list of Storage Management requests shown in the Request Status Information 
table needs to be filtered, make the appropriate selection from the following choices 
listed on the Filtering pull-down menu: 

• Server. 

−� Controls what activity is displayed by limiting the list to the requests 
being/having been serviced by a specific server. 

− Selecting All displays all requests throughout the Storage Management CSCI. 

−� Other selections include the individual archive servers, cache manager servers, 
ftp servers, request manager server, and staging disk servers. 

• Operation. 

−� Allows the Ingest/Distribution Technician to focus on a specific type of 
operation. 
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−� The list of operations is dynamically generated to reflect those operations for 
which requests are currently in queue, for example (among others): 

⋅ All. 

⋅ CMLink. 

⋅ ArStore. 

⋅ FtpPull. 

⋅ FtpPush. 

• Processing State. 

−� Allows the Ingest/Distribution Technician to differentiate among requests that 
are being actively processed; have been completed, either successfully or to a 
retryable error state; or have been suspended and are awaiting the outcome of 
another event. 

− The following selections are available: 

⋅ All. 

⋅ Processing. 

⋅ Suspended. 

⋅ Completed. 

• Submitter. 

−� Allows the Ingest/Distribution Technician to see the status of requests 
submitted by a specific client process. 

−� The list of possible clients is dynamically generated to reflect the list of clients 
with outstanding requests for example (among others) 

⋅ All. 

⋅ DSDD. 

⋅ SDSV. 

⋅ this. 

⋅ [ftp server]. 

⋅  [archive server]. 

⋅ [staging disk server]. 

4	 Observe the Storage Management requests displayed in the Request Status Information 
table. 
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5 Repeat Steps 3 and 4 as necessary to monitor Storage Management requests. 

6	 If it becomes necessary to exit from the Storage Management Control GUI select 
File → Exit from the pull-down menu. 

7 625-CD-609-001




68 6

This page intentionally left blank. 

8 625-CD-609-001




69 6

Tuning System Parameters	

Tuning System Configuration Parameters 

The values assigned to system parameters affect the functioning and performance of the system. 
When certain parameters are modified, the system operates differently. Changes to some other 
parameters may not appear to affect the system although there may in fact be subtle effects.  In 
any case before system parameters are modified it is essential to understand what will happen to 
system functioning and performance. 

Many system parameters may be subject to control by Configuration Management (CM). When 
making or requesting a change to system parameters, the CM process at the particular site must 
be followed (if applicable). 

Values are assigned to Storage Management and Data Distribution parameters in the following 
databases: 

• Storage Management and Data Distribution database. 

• Configuration Registry database. 

The Configuration Registry Server provides a single interface (via a Sybase server) for retrieving 
configuration attribute-value pairs for ECS servers from the Configuration Registry database. 
When ECS servers are started, they access the Configuration Registry Database to obtain needed 
configuration parameters. 

The Database Administrator has access to a Configuration Registry GUI for viewing and editing 
configuration data in the database.  Therefore, it is necessary to coordinate with the Database 
Administrator when changes to configuration parameters are needed.  Also, as previously 
mentioned, changes to configuration-controlled parameters are subject to approval through the 
site CM process. 

Default and adjusted values assigned to system parameters vary from site to site.  For guidance 
concerning the assignment of values to parameters included in the Configuration Registry refer 
to document 910-TDA-022 rev2, Custom Configuration Parameters for ECS Release 6A. The 
document is available at http://cmdm.east.hitc.com/baseline/ under “Technical Documents.” 

The following parameters are examples of parameters whose values may be modified to enhance 
system functioning or performance: 

• AppLogSize 

− Maximum size of the application log (ALOG) file for a particular application. 

• AppLogLevel 

− Level of detail provided in the ALOG file for a particular application. 
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•	 DebugLevel 

− Level of detail provided in the debug log file for a particular application. 

•	 DBMaxConnections 

− Maximum number of database connections allowed a particular application. 

• FtpPushThreshold 

− Maximum number of bytes per distribution request via ftp push. 

−	 The FtpPushThreshold should always be greater than the size of the largest 
input granule used by the Planning and Data Processing Subsystems (PDPS) in 
order to ensure that PDPS distribution requests are processed without manual 
intervention.  For example, at a DAAC that archives MODIS Level 0 (L0) data 
the FtpPushThreshold might be greater than the maximum size of a MODIS L0 
granule (~7GB). 

−	 When a distribution request exceeds a threshold (e.g., FtpPushThreshold or 
FtpPullThreshold), the request is suspended in DDIST. 

•	 FtpPullThreshold 

− Maximum number of bytes per distribution request via ftp pull. 

• Checksum Status 

−	 Check-summing can be enabled or disabled for either acquires or inserts using 
the Storage Config. tab of the Storage Management Control GUI. 

−	 The checksum status entry (for EcDsStArchiveServer) controls whether or not a 
checksum is calculated for each file inserted into the archive. 

−	 Note that checksums are calculated on retrieval only when the file is first 
moved from the archive to the read-only cache.  As long as the file remains 
resident in the read-only cache, the checksum is not recalculated. 

−	 Checksum calculation is a highly time-consuming process, and makes intensive 
use of central processing unit (CPU) resources.  Consequently, enabling check­
summing has significant effects on both archive server and cache manager 
servers. 

• ListenThreads 

− Number of listen threads assigned to a particular application. 

When the value assigned to a parameter has been changed and saved in the Configuration 
Registry, the modified value does not take effect until the affected server has been restarted. For 
example, if the debug level for the Distribution Server log has been changed from “2” to “3” in 
the Configuration Registry, the modification does not affect the recording of data in the log until 
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after a warm restart of the Distribution Server (at which time the server would read the 
parameters in the Configuration Registry). 

Tuning System Parameters in the Storage Management and Data 
Distribution Database 

Staging Area Size and Read-Only Cache Size 

The DsStConfigParameter table in the Storage Management and Data Distribution database has 
columns related to staging area size and read-only cache size. The TotalSpace column contains 
the total size of raid allocated to the associated Cache Manager and staging disk combined. The 
CacheSpace column contains the amount of read-only cache space allocated/available on disk (to 
the associated Cache Manager/staging disk) in block-size increments. 

The staging area size and read-only cache size parameters are tuned in tandem.  They determine 
how much disk space is available for staging of files (both for Ingest and acquires), and how 
large the read-only cache is.  When either area is exhausted, requests hang until space becomes 
available. 

Pull area read-only cache size defaults to 2,000,000,000 (blocks). There is no need for much 
user space because the user files are symbolically linked back to the files in the read-only cache. 

Staging area read-only cache size depends on the server and the data being handled.  Staging 
read-only cache comes out of the same disk space as staging disk.  The more need there is for 
staging disk, the smaller the size of the read-only cache can be.  If the staging disk is being used 
primarily to link files from the read-only cache, the read-only cache can take most of the total 
staging area (90% or so).  If data is being staged in support of Ingest or subsetting of data for 
distribution, the read-only cache should be smaller (e.g., 40% or 50% of the total staging area). 

The parameters are modified using the Storage Management Control GUI. Refer to the 
section on Modifying System Parameters in the Storage Management and Data 
Distribution Database Using the Storage Management Control GUI (subsequent section of 
this lesson) for the applicable procedure. 

Setting the FTP Pull Expiration Time 

Among the columns in the DsStConfigParameter table in the Storage Management and Data 
Distribution database is the PullExpirationTime column.  The value listed for a particular pull 
monitor server specifies the duration (in hours) after which files may be considered for deletion. 

The ftp pull expiration time is used as a cleanup mechanism for files that have not been pulled. 
The appropriate setting for the ftp pull expiration time depends on the following factors: 

• Frequency of files being left behind in the pull area. 

− The more files, the lower the expiration time. 
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• Size of the files. 

− The bigger the files, the lower the expiration time. 

• Capacity of disk used. 

− The higher the capacity used, the lower the expiration time. 

• Pull expiration time defaults to 24 hours. 

The parameter is modified using the Storage Management Control GUI.  Refer to the section 
on Modifying System Parameters in the Storage Management and Data Distribution 
Database Using the Storage Management Control GUI (subsequent section of this lesson) for 
the applicable procedure. 

Priority Thread Allocation 

The DsDdPriorityThread database table holds the threshold for the number of threads that can be 
active for each priority level of distribution requests.  The priorities are set either via a Perl 
script (EcDsDdPTEdit.pl) or through command line sql.  Table 1 lists representative default 
values as listed in the DsDdPriorityThread database table. 

Refer to the section on Modifying PriorityThread Table Values in the Storage Management 
and Data Distribution Database Using the EcDsDdPTEdit.pl Script or the section on 
Modifying System Parameters in the Storage Management and Data Distribution Database 
Using ISQL (subsequent section of this lesson) for the applicable procedure. 

Table 1. Representative Number of Active Threads for Each Priority of 
Distribution Requests (DsDdPriorityThread Database Table) 

ThreadName ThreadLimit 

LOW 28 

NORMAL 128 

HIGH 64 

VHIGH 5 

XPRESS 2 

Modifying System Parameters in the Storage Management and Data Distribution 
Database Using the Storage Management Control GUI 

As previously mentioned the effects on system functioning and performance must be considered 
before modifying system parameters.  In addition, when making or requesting a change to 
system parameters, the CM process at the particular site must be followed (if applicable). 
Depending on circumstances (e.g., operator permissions) at a particular site, it may be necessary 
to request that someone else make parameter modifications using the Storage Management 
Control GUI.  The procedure that follows is provided to assist Ingest/Distribution Technicians 
who have to make parameter modifications using the Storage Management Control GUI. 
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The procedure for changing system parameters using the Storage Management Control GUI 
starts with the assumption that all applicable servers and the Storage Management Control 
GUI are running and the Storage Config. screen (Figure 6) is being displayed. 

Modifying System Parameters in the Storage Management and Data Distribution Database 
Using the Storage Management Control GUI 

1	 Click on Cache Manager in the Configuration Parameter Reporting window on the 
Storage Config. tab. 

•	 The selected server type is highlighted in the Configuration Parameter Reporting 
window on the Storage Config. tab. 

•	 Associated servers are listed in the server information window on the Storage 
Config. tab. 

2	 Click on the appropriate server in the server information window on the Storage Config. 
tab. 

•	 The selected server is highlighted in the server information window on the Storage 
Config. tab. 

4 Click on the Modify Server/View Stackers button. 

• The Cache Manager Server Configuration dialogue box (Figure 16) is displayed. 

•	 The Cache Manager Server Configuration dialogue box (Figure 16) displays data 
in the following fields (as applicable): 

− Server Name. 

− RPC Tag. 

− Original Cache Space (blocks). 

− Available Cache Space (blocks) [cannot be modified from GUI]. 

− Allocation Block Size (bytes). 

− Description [e.g., "Cache Manager"]. 

− Expiration Threshold (hours). 

− Expired Files Confirm Delete [option button with Yes and No as the options]. 

− Disk Capacity: Fault Level. 

− Disk Capacity: Warning Level. 

− File I/O Block Size (bytes). 

− Retries. 
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Figure 16. Cache Manager Server Configuration Dialogue Box 

− Sleeptime (seconds). 

−	 Service Threads [number of worker threads that are allocated within the server 
instance to process requests]. 

− Pull Area Manager [option button with Yes and No as the options]. 
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− Cache Path. 

− User Request Directory. 

− FTP Notification File. 

− FTP Notification Freq (Sec). 

5 Type modified data in relevant field(s) as necessary. 

6	 If service threads are to be allocated by priority in order to reserve certain resources for 
higher priority requests, click on the Allocate by Priority button. 

• The Service Threads: Allocate by Priority window (Figure 17) is displayed. 

7	 If service threads are to be allocated by priority, type the desired values in the 
appropriate fields in the Service Threads: Allocate by Priority window (Figure 17). 

•	 Lower-priority threads may be used to service higher priority requests, but never vice 
versa. 

•	 By default, all service threads are created as low priority service threads, since they 
may be pre-empted by any priority request. 

Figure 17.  Service Threads: Allocate by Priority window 
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•	 The number of low threads is automatically re-calculated whenever the number of 
any of the other thread types is changed. 

−	 Consequently, the total of the numbers in each of the five different thread type 
fields equals the number in the Total field. 

8	 If service threads are to be allocated by priority, click on the appropriate button from the 
following selections: 

•	 OK - to approve the new value(s) and dismiss the Service Threads: Allocate by 
Priority window. 

−	 The Cache Manager Server Configuration dialogue box (Figure 17) is 
displayed. 

•	 Cancel - to return to the Cache Manager Server Configuration dialogue box 
without saving the new value(s). 

−	 The Cache Manager Server Configuration Dialogue Box (Figure 17) is 
displayed. 

9	 When new values have been entered in all fields to be modified, click on the appropriate 
button from the following selections: 

•	 OK - to approve the new value(s) and dismiss the configuration dialogue box. 

− The Storage Config. screen (Figure 6) is displayed. 

• Cancel - to return to the Storage Config. screen without saving the new value(s). 

− The Storage Config. screen (Figure 6) is displayed. 

10 Repeat Steps 1 through 9 as necessary. 

Modifying PriorityThread Table Values in the Storage Management and Data 
Distribution Database Using the EcDsDdPTEdit.pl Script 

The EcDsDdPTEdit.pl script is a tool that can be used to change the limits for priority levels of 
threads in the DsDdPriorityThread database table.  The script operates in either of two modes: 

• Interactive. 

−	 A menu presents the old limits for the priority levels and prompts the technician 
to make necessary changes. 

• Non-Interactive (command line). 

− The technician specifies new limits on the command line (useful for cron jobs). 

As previously mentioned the effects on system functioning and performance must be considered 
before modifying system parameters.  In addition, when making or requesting a change to 
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system parameters, the CM process at the particular site must be followed (if applicable). 
Depending on circumstances at a particular site it may be necessary to request that the Database 
Administrator modify parameters in the Storage Management and Data Distribution database. 
The procedure that follows is provided to assist Ingest/Distribution Technicians who have to 
make the database modifications themselves. 

The procedure for changing PriorityThread table values in the Storage Management and Data 
Distribution Database using the EcDsDdPTEdit.pl Script starts with the assumption that the 
Ingest/Distribution Technician has logged in to the system. 

Modifying PriorityThread Table Values in the Storage Management and Data Distribution 
Database Using the EcDsDdPTEdit.pl Script 

1	 Access a terminal window logged in to the Distribution Server (e.g., e0dis01, g0dis01, 
l0dis02 or n0dis01). 

• If values in the Storage Management and Data Distribution Database using…. 

− Non-interactive mode, perform Step 2. 

− Interactive mode, perform Steps 3 through 7. 

2	 Type EcDsDdPTEdit.pl  USER userID  PASSWORD password  DBNAME 
DBName SERVER DBServer PRIORITYLEVEL #threads  [PRIORITYLEVEL 
#threads]  [PRIORITYLEVEL #threads] […] then press Return/Enter. 

• For example: 

EcDsDdPTEdit.pl  USER stmgt_role  PASSWORD greetings DBNAME 
stmgtdb1_TS1 SERVER x0acg01_srvr HIGH 60 LOW 32 

− Would set the thread limits for HIGH and LOW priorities in TS1 mode. 

− Thread limit for HIGH priority would be set at 60 threads. 

− Thread limit for LOW priority would be set at 32 threads. 

•	 If necessary type SYBASE sybase_home_dir after SERVER DBServer, for 
example: 

EcDsDdPTEdit.pl  USER stmgt_role  PASSWORD greetings DBNAME 
stmgtdb1_TS1 SERVER x0acg01_srvr SYBASE  /tools/sybOCv11.1.1 HIGH 
60 LOW 32 

• The script makes the specified changes (end of procedure). 
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-----------

3	 To use interactive mode type EcDsDdPTEdit.pl  USER userID  PASSWORD 
password  DBNAME DBName SERVER DBServer then press Return/Enter. 

• For example: 

EcDsDdPTEdit.pl USER stmgt_role PASSWORD greetings DBNAME 
stmgtdb1_TS1 SERVER x0acg01_srvr 

•	 If necessary type SYBASE sybase_home_dir after SERVER DBServer, for 
example: 

EcDsDdPTEdit.pl  USER stmgt_role  PASSWORD greetings DBNAME 
stmgtdb1_TS1 SERVER x0acg01_srvr SYBASE  /tools/sybOCv11.1.1 

•	 A menu similar to the following one is displayed: 

Configuration Parameter Change Menu 

Priority  Nr. Threads 

-------­

1. HIGH  16, 

2. LOW  16, 

3. NORMAL  16, 

4. VHIGH  16, 

5. XPRESS  16, 

Enter number of Priority (1 - 5) to change, q to quit, or s to save and exit. 

4	 Type the number corresponding to the priority thread to be modified at the Enter 
number of Priority.… prompt then press Return/Enter. 

•	 For example: 

1 

•	 The script responds with the following type of message: 

value of HIGH is 16, 

Enter new value for HIGH 
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-----------

5	 Type the new value for the number of priority threads for the specified priority then 
press Return/Enter. 

•	 For example: 

10 

•	 The value in the table associated with the menu changes to the value entered; for 
example: 

Configuration Parameter Change Menu 

Priority  Nr. Threads 

-------­

1. HIGH  10, 

2. LOW  16, 

3. NORMAL  16, 

4. VHIGH  16, 

5. XPRESS  16, 

Enter number of Priority (1 - 5) to change, q to quit, or s to save and exit. 

6	 Repeat Steps 4 and 5 as necessary to enter new values for all PriorityThread table values 
to be modified. 

7	 When new values have been entered for all PriorityThread table values to be modified, 
type the appropriate response from the following selections then press Return/Enter: 

•	 s - to implement the new PriorityThread table values and dismiss the Configuration 
Parameter Change Menu. 

−	 The following message is displayed while the new values are being saved to the 
database: 

ok, saving values... 

•	 q - to dismiss the Configuration Parameter Change Menu without implementing 
the new PriorityThread table values. 
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Modifying System Parameters in the Storage Management and Data Distribution 
Database Using ISQL 

As previously mentioned the effects on system functioning and performance must be considered 
before modifying system parameters.  In addition, when making or requesting a change to 
system parameters, the CM process at the particular site must be followed (if applicable). 
Depending on circumstances at a particular site it may be necessary to request that the Database 
Administrator modify parameters in the Storage Management and Data Distribution database. 
The procedure that follows is provided to assist Ingest/Distribution Technicians who have to 
make the database modifications themselves. 

The procedure for changing system parameters specified in the Storage Management and Data 
Distribution database using interactive structured query language (isql) starts with the 
assumption that the Ingest/Distribution Technician has logged in to the system. 

Modifying System Parameters in the Storage Management and Data Distribution Database 
Using ISQL 

1	 Access a terminal window logged in to the Access/Process Coordinators (APC) Server 
(e.g., e0acg01, g0acg01, l0acg02 or n0acg01). 

2 Type isql –UuserID  -SDBServer then press Return/Enter. 

• For example: 

isql –Ustmgt_role –Sx0acg01_srvr 

3 At the Password: prompt type dbpassword then press Return/Enter. 

•	 The dbpassword is the password for logging in to the database using the specified 
userID. 

4 Type use dbname at the 1> prompt then press Return/Enter. 

•	 The dbname is likely to be one of the following names: 

− stmgtdb1 [OPS mode]. 

− stmgtdb1_TS1 [TS1 mode]. 

− stmgtdb1_TS2 [TS2 mode]. 

5 Type go at the 2> prompt then press Return/Enter. 

6 Type select * from TableName at the 1> prompt then press Return/Enter. 

•	 For example: 

select * from DsDdPriorityThread 
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•	 Alternatively, type select columnName from TableName at the 1> prompt then 
press Return/Enter. 

− For example: 

select ThreadLimit from DsDdPriorityThread 

•	 Another alternative is to type 
select columnName1,columnName2[,columnName3,…] from TableName at the 1> 
prompt then press Return/Enter. 

− For example: 

select ThreadName,ThreadLimit from DsDdPriorityThread 

7 Type go at the 2> prompt then press Return/Enter. 

• Table contents are displayed. 

− If * (wildcard) was specified, all entries in the table are displayed. 

−	 If specific columnNames were entered, the data associated with those columns 
only are displayed. 

• For example: 
1> select * from DsDdPriorityThread

2> go

ThreadName ThreadLimit

------------ -----------

HIGH 64

LOW 28

NORMAL 128

VHIGH 5

XPRESS 2

(5 rows affected)


8 Type update TableName set columnName1=value1 where columnName2=value2 at 
the 1> prompt then press Return/Enter. 

• For example: 

update DsDdPriorityThread set ThreadLimit=125 where 
ThreadName=NORMAL 

9 Type go at the 2> prompt then press Return/Enter. 

10	 Start verification of the update by typing select * from TableName (or one of the 
options described in Step 6) at the 1> prompt then pressing Return/Enter. 

11 Type go at the 2> prompt then press Return/Enter. 

• Table contents are displayed. 

• Specified value should have been updated. 
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• For example: 
1> select * from DsDdPriorityThread

2> go

ThreadName ThreadLimit

------------ -----------

HIGH 64

LOW 28

NORMAL 125

VHIGH 5

XPRESS 2

(5 rows affected)


12 To exit from isql type quit at the 1> prompt then press Return/Enter. 
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Troubleshooting Data Distribution Problems


Trouble Symptoms 

Troubleshooting is a process of identifying the source of problems on the basis of observed 
trouble symptoms.  Most problems with data distribution can be traced to some part of the Data 
Server Subsystem: 

• Data Distribution. 

• Science Data Server. 

• Storage Management. 

However, a common source of problems involves the reliance on messages or data from other 
subsystems. Like many other operational areas in ECS, data distribution has interfaces with 
other subsystems.  Consequently, it is possible to trace some problems to another ECS 
subsystem, including (but not necessarily limited to) those in the following list: 

• Communications Subsystem (CSS). 

• System Management Subsystem (MSS). 

Table 2 describes actions to be taken in response to some common data distribution problems. If 
the problem cannot be identified and fixed without help within a reasonable period of time, the 
appropriate response is to call the help desk and submit a trouble ticket in accordance with site 
Problem Management policy. 
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Table 2.  Troubleshooting Data Distribution Problems 
Symptom Response 

Unable to log in to any host (e.g., 
Distribution Server, g0dis02). 

Check with the Operations Controller/System Administrator to 
ensure that the host is “up." 

GUI not displayed when the start-up 
script has been properly invoked. 

Ensure that the DISPLAY variable was set properly. 
[For detailed instructions refer to the procedure for Launching the 
Data Distribution Operator and Storage Management Control 
GUIs (previous section of this lesson).] 

Error message associated with the 
Data Distribution Operator GUI. 

Refer to Table 3, Data Distribution Operator GUI User Messages 
(adapted from the corresponding table in 609-CD-600-001, 
Release 6A Operations Tools Manual for the ECS Project). 

Request status change to 
“Suspended with Errors,” indicating 
a data distribution failure. 

1.  Ensure (e.g., using ECS Assistant) that the necessary hosts 
and servers (listed in Table 4) are “up.” 
2. If hosts/servers have gone down, notify the Operations 
Controller/System Administrator to have servers brought back up. 
3. If hosts/servers are all “up,” notify the Operations 
Controller/System Administrator to have the STMGT servers 
bounced (shut down and immediately restarted). 
4. Resume processing of the suspended request. 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests (previous 
section of this lesson).] 
5. If processing does not resume, refer to the procedure for 
Recovering from a Data Distribution Failure (subsequent 
section of this lesson). 

Other problems. Check the log files (e.g., EcDsDdistGui.ALOG, 
EcDsDistributionServer.ALOG, EcDsStStagingDiskServer.ALOG, 
EcDsStCacheManagerServer.ALOG) in the 
/usr/ecs/MODE/CUSTOM/logs directory of the Distribution Server 
host for error messages. 
[For detailed instructions refer to the procedure for Checking Log 
Files (subsequent section of this lesson).] 
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Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

Cannot create 
connection pool. 

Attempt to create 
connection pool to 
database failed. 

1.  Refresh the GUI display (click on the Refresh 
button). 
2.  Check the database connections. 
[For detailed instructions refer to the procedure for 
Checking Database Connections (subsequent section 
of this lesson).] 
3. Refresh the GUI display (click on the Refresh 
button). 
4.  If the problem recurs, call the help desk and submit 
a trouble ticket in accordance with site Problem 
Management policy. 

Cannot create the 
DsDdDistRequestList. 

The Data Distribution 
Request List was not 
created. 

1.  Refresh the GUI display (click on the Refresh 
button). 
2.  Check the database connections. 
[For detailed instructions refer to the procedure for 
Checking Database Connections (subsequent section 
of this lesson).] 
3. Refresh the GUI display (click on the Refresh 
button). 
4.  If the problem recurs, call the help desk and submit 
a trouble ticket in accordance with site Problem 
Management policy. 

Cannot get a 
dbInterface 
connection pool. 

Attempt to get a 
dbInterface from 
connection pool to 
database failed. 

1.  Refresh the GUI display (click on the Refresh 
button). 
2.  Check the database connections. 
[For detailed instructions refer to the procedure for 
Checking Database Connections (subsequent section 
of this lesson).] 
3. Refresh the GUI display (click on the Refresh 
button). 
4.  If the problem recurs, call the help desk and submit 
a trouble ticket in accordance with site Problem 
Management policy. 

5 625-CD-609-001




86 8

Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

DDist Cancel Failure. GUI received failure 
from server.  Request 
was not canceled. 

1.  Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Canceling 
the request may not be a valid operation in the current 
state (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to cancel the request. 
[For detailed instructions refer to the procedure for 
Canceling Data Distribution Requests (previous 
section of this lesson).] 
6.  If repeated attempts to cancel the request fail, call 
the help desk and submit a trouble ticket in accordance 
with site Problem Management policy. 

DDist Mark Shipped 
Failure. 

GUI received failure 
from server.  Request 
was not marked 
“Shipped.” 

No Longer Applicable. 

DDist Refresh 
Failure. 

Data Distribution 
Refresh Error. 
Dialogue Message 
GUI was not able to 
get new request list 
from server. 

1.  Check the database connections. 
[For detailed instructions refer to the procedure for 
Checking Database Connections (subsequent section 
of this lesson).] 
2. Refresh the GUI display (click on the Refresh 
button). 
3.  If the problem recurs, call the help desk and submit 
a trouble ticket in accordance with site Problem 
Management policy. 
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Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

DDist Resume All 
Failure. 

GUI received failure 
from server. 
Requests were not 
resumed. 

1.  Check the current state of the distribution request(s) 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Resuming 
the request(s) may not be a valid operation in the 
current state(s) (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to resume the request(s). 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests 
(previous section of this lesson).] 
6.  If repeated attempts to resume request processing 
fail, call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 

DDist Resume 
Failure. 

GUI received failure 
from server.  Request 
was not resumed. 

1.  Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Resuming 
the request may not be a valid operation in the current 
state (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to resume the request. 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests 
(previous section of this lesson).] 
6.  If repeated attempts to resume request processing 
fail, call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 
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Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

DDist Set Priority 
Failure. 

GUI received failure 
from server.  Request 
set priority failed. 

1. Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Setting 
priority may not be a valid operation in the current state 
(e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the server has gone down, notify the Operations 
Controller/System Administrator to have it brought back 
up. 
4.  Try again to set the priority of the selected 
distribution request. 
[For detailed instructions refer to the procedure for 
Changing the Priority of Data Distribution Requests 
(previous section of this lesson).] 
5.  If repeated attempts to set the request priority fail, 
call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 

DDist Suspend All 
Failure. 

GUI received failure 
from server. 
Requests will not be 
submitted in a 
SuspendAll state. 

1.  Check the current state of the distribution request(s) 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Suspending 
the request(s) may not be a valid operation in the 
current state(s) (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to suspend the request(s). 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests 
(previous section of this lesson).] 
6.  If repeated attempts to suspend request processing 
fail, call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 

8 625-CD-609-001




89 8

Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

DDist Suspend 
Failure. 

GUI received failure 
from server.  Request 
was not suspended. 

1.  Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Suspending 
the request may not be a valid operation in the current 
state (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to suspend the request. 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests 
(previous section of this lesson).] 
6.  If repeated attempts to suspend request processing 
fail, call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 

DsDdRequestMgrC 
Cancel Failure. 

GUI received failure 
from server.  Request 
was not canceled. 

1.  Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Canceling 
the request may not be a valid operation in the current 
state (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to cancel the request. 
[For detailed instructions refer to the procedure for 
Canceling Data Distribution Requests (previous 
section of this lesson).] 
6.  If repeated attempts to cancel the request fail, call 
the help desk and submit a trouble ticket in accordance 
with site Problem Management policy. 
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Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

DsDdRequestMgrC 
create handle error. 

Error cannot create 
Request Manager 
Handle to the Data 
Distribution Server. 

1.  Click on the Refresh button to try again. 
2.  Check the database connections. 
[For detailed instructions refer to the procedure for 
Checking Database Connections (subsequent section 
of this lesson).] 
3. Refresh the GUI display (click on the Refresh 
button). 
4.  If the problem recurs, call the help desk and submit 
a trouble ticket in accordance with site Problem 
Management policy. 

DsDdRequestMgrC 
Mark Shipped Failure. 

GUI received failure 
from server.  Request 
was not marked 
“Shipped.” 

No Longer Applicable. 

DsDdRequestMgrC 
Resume Failure. 

GUI received failure 
from server.  Request 
was not resumed. 

1.  Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Resuming 
the request may not be a valid operation in the current 
state (e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the Distribution Server has gone down, notify the 
Operations Controller/System Administrator to have the 
server brought back up. 
4.  Refresh the GUI display (click on the Refresh 
button). 
5.  Try again to resume the request. 
[For detailed instructions refer to the procedure for 
Suspending/Resuming Data Distribution Requests 
(previous section of this lesson).] 
6.  If repeated attempts to resume request processing 
fail, call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 

0 625-CD-609-001




91 9

Table 3. Data Distribution Operator GUI User Messages 
Message Text Impact Cause and Corrective Action 

DsDdRequestMgrC 
Set Priority Failure. 

GUI received failure 
from server.  Request 
priority was not 
changed. 

1. Check the current state of the distribution request 
(State column of the Data Distribution Requests list 
on the Distrib’n Requests tab (Figure 5)).  Setting 
priority may not be a valid operation in the current state 
(e.g., if the current state is “Shipped”). 
2.  Ensure (e.g., using ECS Assistant) that the 
Distribution Server is “up.” 
3.  If the server has gone down, notify the Operations 
Controller/System Administrator to have it brought back 
up. 
4.  Try again to set the priority of the selected 
distribution request. 
[For detailed instructions refer to the procedure for 
Changing the Priority of Data Distribution Requests 
(previous section of this lesson).] 
5.  If repeated attempts to set the request priority fail, 
call the help desk and submit a trouble ticket in 
accordance with site Problem Management policy. 

Invalid text field entry. Invalid data was 
entered. 

1.  Enter valid data in the relevant field. 
2.  Retry the operation that led to the error message. 

No Ddist request 
selected. Please 
select one. 

An operation was 
performed without 
first selecting a 
request from the 
scrolled list. 

1.  Select (highlight) the appropriate request in the list. 
2.  Retry the operation that led to the error message. 
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Table 4. Hosts, Servers, Clients and Other Software Relevant to Data 
Distribution 

HOST SERVER/CLIENT/OTHER SOFTWARE 

Distribution Server (e.g., x0dis02) Data Distribution Operator GUI (EcDsDdistGui) 
Distribution Server (EcDsDistribution Server) 
Staging Disk Server (EcDsStStagingDiskServer) 
Storage Management Request Manager 
(EcDsStRequestManagerServer) 

Working Storage (e.g., x0wkg01) HDF EOS Server (EcDsHdfEosServer) 
Archive Server (EcDsStArchiveServer) 
Cache Manager Server (EcDsStCacheManagerServer) 
FTP Server (EcDsStFtpServer) 
Staging Disk Server (EcDsStStagingDiskServer) 

SDSRV Server (e.g., x0acs03) Science Data Server (EcDsScienceDataServer) 

Access/Process Coordinators (APC) 
Server (e.g., x0acg01) 

Archive Server (EcDsStArchiveServer) 
Cache Manager Server (EcDsStCacheManagerServer) 
FTP Server (EcDsStFtpServer) 
Staging Disk Server (EcDsStStagingDiskServer) 
Pull Monitor Server (EcDsStPullMonitorServer) 

FSMS Server (e.g., x0drg01) Archive Server (EcDsStArchiveServer) 
Cache Manager Server (EcDsStCacheManagerServer) 
FTP Server (EcDsStFtpServer) 
Staging Disk Server (EcDsStStagingDiskServer) 

Ingest Server (e.g., x0icg01) Registry Server (EcCsRegistry) 

Interface Server 02 (e.g., x0ins01) Subscription Server (EcSbSubServer) 
Event Server (EcSbEventServer) 

Recovering from a Data Distribution Failure 

The automated data distribution processes (push and pull) normally do not require intervention 
by the Ingest/Distribution Technician.  However, when a data distribution fault (error) occurs, 
there may be a requirement for action to recover from the error. For example, recovery actions 
may be made necessary by the failure of storage management to acquire granules from the 
archive so they can be distributed. When a fault (error) occurs, the request status on the 
Distrib’n Requests tab of the Data Distribution Operator GUI is likely to change to 
“Suspended with Errors.” 

The Ingest/Distribution Technician may use the Data Distribution Operator GUI Distrib’n 
Requests tab (refer to the section on Monitoring/Controlling Data Distribution Requests) and/or 
log files on various host machines to review the failure event. 
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When recovering from a data distribution failure, use the procedure that follows.  The procedure 
starts with the assumption that all applicable servers and the Data Distribution Operator GUI 
are currently running and the Distrib’n Requests screen (Figure 5) is being displayed. 

Recovering from a Data Distribution Failure 

1	 Observe the information displayed on the Distrib’n Requests tab of the Data 
Distribution Operator GUI to identify distribution requests with a status of 
“Suspended with Errors.” 

2	 If a suspended request has the error mnemonic DsEDdXLargeRequest associated with 
it, perform the procedure for Responding to Requests that Exceed the Distribution 
Request Threshold (subsequent section of this lesson). 

3	 Perform the procedure for Handling an Acquire Failure (subsequent section of this 
lesson). 

4	 If additional information is needed, open and read the appropriate log file in the 
/usr/ecs/MODE/CUSTOM/logs directory on the appropriate host machine(s). 

•	 Applicable host machines are listed in Table 4.  Hosts, Servers, Clients and Other 
Software Relevant to Data Distribution. 

•	 For detailed instructions refer to the procedure for Checking Log Files (subsequent 
section of this lesson). 

5	 If the problem could not be identified through any of the preceding steps, call the help 
desk and submit a trouble ticket in accordance with site Problem Management policy. 

6	 When the problem has been corrected, review the information displayed on the Distrib’n 
Requests tab of the Data Distribution Operator GUI to determine whether the 
distribution request resumed processing. 

7	 If the distribution request does not resume processing after the problem has been 
corrected, return to Step 3. 

Responding to Requests that Exceed the Distribution Request Threshold 

When a distribution request exceeds the corresponding distribution request threshold (e.g., 
FtpPushThreshold or FtpPullThreshold), the request is suspended in DDIST with the following 
error mnemonic: 

• DsEDdXLargeRequest 

The procedure for responding to requests that exceed the distribution request threshold starts 
with the assumption that all applicable servers and the Data Distribution Operator GUI are 
currently running and the Distrib’n Requests screen (Figure 5) is being displayed. 
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Responding to Requests that Exceed the Distribution Request Threshold 

1	 Contact User Services to determine whether or not the user’s request should be 
processed. 

•	 User Services may contact the requester to verify whether or not the requester 
intended to order so much data. 

2	 If User Services responds that the request should be aborted, perform the procedure for 
Canceling Data Distribution Requests (previous section of this lesson). 

•	 An e-mail message is automatically sent to the requester indicating that the request 
was cancelled through operator intervention. 

•	 User Services should follow up with an additional e-mail message to the requester 
explaining the rationale for not completing the request. 

3	 If User Services responds that the request should be completed, first determine whether 
the request should be resumed immediately or should be left suspended until an off-hours 
period when the system is less loaded. 

•	 Another alternative may be to submit a request to the Database Administrator to 
increase (at least temporarily) the corresponding threshold. 

4	 If the request should be completed, perform the procedure for Suspending/Resuming 
Data Distribution Requests (previous section of this lesson). 

Handling an Acquire Failure 

Diagnosing an acquire failure involves examining the following system log files and directories 
involved in the process: 

• Science Data Server ALOG File (EcDsScienceDataServer.ALOG file). 

• Archive Server ALOG File (EcDsStArchiveServer.ALOG). 

• Staging Area. 

− Presence of the relevant file. 

−	 Staging Disk ALOG File (EcDsStStagingDiskServer.ALOG or 
EcDsStCacheManagerServer.ALOG). 

− Space available in the staging area. 
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Checking the Science Data Server ALOG File 

The procedure for checking the EcDsScienceDataServer.ALOG file starts with the assumption 
that the operator has logged in to the ECS system. 

Checking the Science Data Server ALOG File 

1	 Log in to the SDSRV Server host (e.g., e0acs05, g0acs03, l0acs03, n0acs04) as described 
in Steps 1 through 5 of the procedure for Launching the Data Distribution Operator 
and Storage Management Control GUIs (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

3 Type view EcDsScienceDataServer.ALOG then press Return/Enter. 

•	 Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more) can be used to review the log file. 

4 Review the log file to determine whether the relevant file was successfully acquired. 

•	 The EcDsScienceDataServer.ALOG file should contain entries identifying the file to 
be acquired by the ShortName of the corresponding ESDT. 

•	 The EcDsScienceDataServer.ALOG file should contain entries regarding the acquire 
activity.  The following types of messages should be included in the ALOG file: 

Msg: File 1 to be distributed: :SC:MOD03.001:1369:1.HDF-EOS 

Priority: 0 Time : 07/29/98 12:35:42 

PID : 24279:MsgLink :1684108385 meaningfulname 
:DsSrWorkingCollectionDistributeOneDistributFile 

Msg: File 2 to be distributed: SCMOD03.0011369.met 

•	 If the ShortName does not appear in the ALOG file, with a timestamp corresponding 
to the time of the attempted acquire, SDSRV may not be running, or may not be 
communicating with other servers. 

•	 If the ALOG file does contain entries for that ShortName, and indicates that two files 
(the file and its associated metadata file) are being distributed, SDSRV has completed 
its role in the acquire. 

•	 If the ALOG contains the ShortName, and also contains an error showing that the 
data file time stamp does not match the time stamp required by the acquire, the data 
file needs to be removed from the Science Data Server and reinserted. 

− This is usually done using a script called DsDbCleanGranules. 

5 Type :q!  then press Return/Enter to quit the view application. 
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6	 If the ShortName does not appear in the ALOG file, with a timestamp corresponding to 
the time of the attempted acquire, ensure (e.g., using ECS Assistant) that the necessary 
hosts and servers (listed in Table 4) are “up.” 

•	 If hosts/servers have gone down, notify the Operations Controller/System 
Administrator to have servers brought back up. 

•	 Return to the procedure for Troubleshooting a Data Distribution Failure after the 
problem has been corrected. 

7	 If the ALOG contains the ShortName, and also contains an error showing that the data 
file time stamp does not match the time stamp required by the acquire, notify the Archive 
Manager to have the data file removed from the Science Data Server and reinserted. 

•	 Return to the procedure for Troubleshooting a Data Distribution Failure after the 
problem has been corrected. 

8	 If the ALOG file does contain entries for the ShortName and indicates that two files (the 
file and its associated metadata file) are being distributed, continue with the procedure 
for Checking the Archive Server ALOG File. 

Checking the Archive Server ALOG File 

Acquire success from the Science Data Server is only part of the acquire process.  Since any file 
entered into SDSRV is stored in the archive, the Archive Server must be involved during an 
acquire.  Consequently, it may be useful to inspect the Archive Server ALOG file 
(EcDsStArchiveServer.ALOG ) to check for error messages associated with the ShortName of 
the file type. 

The procedure for checking the archive server ALOG file starts with the assumption that the 
operator has logged in to the ECS system. 

Checking the Archive Server ALOG File 

1	 Log in to the Distribution Server (e.g., e0drg01, g0 drg01, l0 drg01, n0 drg01) host as 
described in Steps 1 through 5 of the procedure for Launching the Data Distribution 
Operator and Storage Management Control GUIs (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

3 Type view EcDsStArchiveServer.ALOG then press Return/Enter. 

•	 Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more) can be used to review the log file. 

4 Review the log file to determine whether the relevant file was successfully acquired. 
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5 Type :q!  then press Return/Enter to quit the view application. 

6	 If the relevant file was not successfully acquired, notify the Archive Manager to have the 
data file reacquired for Data Processing. 

•	 Return to the procedure for Troubleshooting a Data Distribution Failure after the 
problem has been corrected. 

7	 If the relevant file was successfully acquired, continue with the procedure for Checking 
the Staging Disk. 

Checking the Staging Disk 

During an acquire, files are copied to a staging area as an intermediate step before distributing 
them to their destination. As part of diagnosing an acquire failure it is useful to check the 
staging area to ascertain whether the files have completed part of their journey.  A subdirectory 
containing both the data granule and metadata file should be written to the staging area. 

The procedure for checking the staging disk starts with the assumption that the operator has 
logged in to the ECS system. 

Checking the Staging Disk 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching the Data Distribution 
Operator and Storage Management Control GUIs (previous section of this lesson). 

2	 Type cd  /usr/ecs/MODE/CUSTOM/drp/archivehost/data/staging/user#  then press 
Return/Enter. 

3 Type ls  -lrt  then press Return/Enter. 

4 Review the directory to determine whether the relevant file was successfully staged. 

5	 If the relevant file was successfully staged, ensure (e.g., using ECS Assistant) that the 
necessary hosts and servers (listed in Table 4) are “up.” 

•	 If hosts/servers have gone down, notify the Operations Controller/System 
Administrator to have servers brought back up. 

•	 Return to the procedure for Troubleshooting a Data Distribution Failure after the 
problem has been corrected. 

6	 If the relevant file was not successfully staged, continue with the procedure for 
Checking the Staging Disk ALOG File to determine why it was not successfully 
staged. 
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Checking the Staging Disk ALOG File 

If the failure occurs in copying the files to the staging area, then the Staging log files 
(EcDsStStagingDiskServer.ALOG or EcDsStCacheManagerServer.ALOG) may reveal the 
cause. 

The procedure for checking the staging disk ALOG file starts with the assumption that the 
operator has logged in to the ECS system. 

Checking the Staging Disk ALOG File 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching the Data Distribution 
Operator and Storage Management Control GUIs (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/logs  then press Return/Enter. 

3	 Type view  EcDsStStagingDiskServer.ALOG or 
EcDsStCacheManagerServer.ALOG then press Return/Enter. 

•	 Although this procedure has been written for the view command, any UNIX editor or 
visualizing command (e.g., vi, pg, more) can be used to review the log file. 

4 Review the log file to determine whether the relevant file was successfully staged. 

5 Type :q!  then press Return/Enter to quit the view application. 

6	 If the relevant file was successfully staged, ensure (e.g., using ECS Assistant) that the 
necessary hosts and servers (listed in Table 4) are “up.” 

•	 If hosts/servers have gone down, notify the Operations Controller/System 
Administrator to have servers brought back up. 

•	 Return to the procedure for Troubleshooting a Data Distribution Failure after the 
problem has been corrected. 

7	 If the relevant file was not successfully staged, continue with the procedure for 
Checking the Space Available in the Staging Area. 

Checking the Space Available in the Staging Area 

Failure can be caused by a lack of space in the staging area. 

The procedure for checking the space available in the staging area starts with the assumption that 
the operator has logged in to the ECS system. 
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Checking the Space Available in the Staging Area 

1	 Log in to the Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host as 
described in Steps 1 through 5 of the procedure for Launching the Data Distribution 
Operator and Storage Management Control GUIs (previous section of this lesson). 

2 Type cd  /usr/ecs/MODE/CUSTOM/drp/archivehost/data/ then press Return/Enter. 

3 Type df  -k . (being sure to include the dot) then press Return/Enter. 

4	 Review the available space listed to determine whether there is adequate space for 
staging the relevant file. 

5	 If there is not adequate space for staging the relevant file, notify the Operations 
Controller/System Administrator of the lack of space. 

6	 If there is adequate space for staging the relevant file, notify the Archive Manager to 
have the data file reacquired for Data Processing. 

7	 Go to the procedure for Troubleshooting a Data Distribution Failure after the problem 
has been corrected. 

Checking Log Files 

Log files can provide indications of the following types of problems: 

• DCE problems. 

• Database problems. 

• Lack of disk space. 

The procedure for checking log files starts with the assumption that the operator has logged in to 
the ECS system and the appropriate host. 

Checking Log Files 

Access a terminal window logged in to the appropriate host. 

•	 Distribution Server (e.g., e0dis02, g0dis02, l0dis02, n0dis02) host has the following 
data distribution and storage management log files: 

− EcDsDdistGui.ALOG. 

− EcDsDistributionServer.ALOG. 

− EcDsStStagingDiskServer.ALOG. 
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− EcDsStCacheManagerServer.ALOG. 

− EcDsStmgtGui.ALOG. 

• APC Server (e.g., e0acg01, g0acg01, l0acg02, n0acg01) host has the following 
storage management log files: 

− EcDsStArchiveServer.ALOG. 

− EcDsStStagingDiskServer.ALOG. 

− EcDsStCacheManagerServer.ALOG. 

•	 FSMS Server (e.g., e0drg01, g0drg01, l0drg01, n0drg01) host has the following 
storage management log files: 

− EcDsStArchiveServer.ALOG 

− EcDsStStagingDiskServer.ALOG. 

− EcDsStCacheManagerServer.ALOG. 

•	 Working Storage (e.g., e0wkg01, g0wkg01, l0wkg01) host has the following storage 
management log files: 

− EcDsStArchiveServer.ALOG. 

− EcDsStStagingDiskServer.ALOG. 

− EcDsStCacheManagerServer.ALOG. 

•	 SDSRV Server (e.g., e0acs05, g0acs03, l0acs03, n0acs04) host has the following 
science data server log files: 

− EcDsHdfEosServer.ALOG. 

− EcDsScienceDataServer.ALOG 

− EcDsScienceDataServerClient.ALOG. 

− EcDsSdSrvGui.ALOG. 

•	 Interface Server 02 (e.g., e0ins01, g0ins01, l0ins01, n0ins01) host has the 
EcSbSubServer.ALOG file. 

Type cd  /usr/ecs/MODE/CUSTOM/logs then press Return/Enter. 

•	 Change directory to the directory containing the data distribution, science data server, 
or storage management log files (e.g., EcDsDdistGui.ALOG, 
EcDsDistributionServer.ALOG). 
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3 Type pg filename then press Return/Enter. 

•	 filename refers to the data distribution, science data server, or storage management 
log file to be reviewed (e.g., EcDsDdistGui.ALOG, EcDsDistributionServer.ALOG). 

• The first page of the log file is displayed. 

•	 Although this procedure has been written for the pg command, any UNIX editor or 
visualizing command (e.g., vi, view, more) can be used to review the log file. 

4 Review the log file to identify problems that have occurred. 

5 Respond to problems as follows: 

• DCE problems. 

−	 Notify the Operations Controller/System Administrator of suspected DCE 
problems. 

• Database problems. 

− Verify that relevant database servers are running. 

−	 Check for lack of (or corruption of) data in the database using either a database 
browser or isql commands. 

− Notify the Database Administrator of suspected database problems. 

• Lack of disk space. 

− Remove unnecessary files. 

−	 Notify the Operations Controller/System Administrator of recurring disk space 
problems. 

Checking Database Connections 

The storage management/data distribution shared database is the repository of data concerning 
data distribution requests.  If applications (including the Data Distribution Operator GUI) are 
unable to connect to the database, the data distribution request data cannot be retrieved or (in the 
case of the GUI) displayed.  Consequently, if the GUI does not display data or if the display 
does not refresh, checking the database connections is a logical step in trying to isolate the 
problem. 

The procedure for checking database connections starts with the assumption that the operator has 
logged in to the ECS system. 
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Checking Database Connections 

1	 Submit a request to the Database Administrator to identify the values for the following 
parameters associated with the EcDsDistributionServer: 

• DBName. 

• DBServer. 

• DBMaxConnections. 

2	 Access a terminal window logged in to the APC Server (e.g., e0acg01, g0acg01, l0acg02, 
n0acg01) host. 

•	 APC Server (e.g., e0acg01, g0acg01, l0acg02, n0acg01) typically hosts Sybase for 
the storage management/data distribution shared database. 

3 Type isql –UuserID  -SDBServer then press Return/Enter. 

• For example: 

isql –Ustmgt_role –Sx0acg01_srvr


4 At the Password: prompt type dbpassword then press Return/Enter. 

•	 The dbpassword is the password for logging in to the database using the specified 
userID. 

5 Type sp_who at the 1> prompt then press Return/Enter. 

6 Type go at the 2> prompt then press Return/Enter. 

• A listing similar to the following one is displayed (some lines have been deleted): 
spid status loginame hostname blk


dbname cmd

------ ------------ ------------------------------ ---------- ----­


------------------------------ ---------------­

1 recv sleep stmgt_role x0acs03 0


stmgtdb1_TS1 AWAITING COMMAND

2 sleeping NULL 0


master NETWORK HANDLER

3 sleeping NULL 0


master DEADLOCK TUNE

4 sleeping NULL 0


master MIRROR HANDLER

5 sleeping NULL 0


master HOUSEKEEPER

6 sleeping NULL 0


master CHECKPOINT SLEEP

7 sleeping NULL 0


master AUDIT PROCESS

8 recv sleep stmgt_role x0ais01 0


stmgtdb1_TS1 AWAITING COMMAND
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 9 recv sleep EcDsStArchiveServer 0

stmgtdb1_TS2 AWAITING COMMAND


10 recv sleep EcInReqMgr 0

Ingest_TS3 AWAITING COMMAND


11 recv sleep EcDsStCacheManagerServer 0

stmgtdb1_TS2 AWAITING COMMAND


12 recv sleep EcDsStStagingDiskServer 0

stmgtdb1_TS2 AWAITING COMMAND


13 recv sleep EcInGran x0icg01 0

Ingest_TS3 AWAITING COMMAND


14 recv sleep EcDsStFtpServer 0

stmgtdb1_TS2 AWAITING COMMAND


15 recv sleep EcDsStArchiveServer 0

stmgtdb1_TS1 AWAITING COMMAND


16 recv sleep EcDsStCacheManagerServer 0

stmgtdb1_TS1 AWAITING COMMAND


17 recv sleep EcDsStStagingDiskServer 0

stmgtdb1_TS1 AWAITING COMMAND


18 recv sleep EcInGran 0

Ingest_TS3 AWAITING COMMAND


19 recv sleep EcDsStStagingDiskServer 0

stmgtdb1_TS1 AWAITING COMMAND


20 recv sleep EcInGUI 0

Ingest_TS1 AWAITING COMMAND


21 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


22 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


23 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


24 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


25 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


26 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


27 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


28 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


29 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


30 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


31 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


32 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


33 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


34 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


35 recv sleep EcDsDistributionServer 0

stmgtdb1_TS1 AWAITING COMMAND


36 recv sleep EcInPolling 0

Ingest_TS1 AWAITING COMMAND


[…]

49 recv sleep EcDsStmgtGui 0
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 stmgtdb1_TS1 

50 recv sleep EcDsDdistGui 


stmgtdb1_TS1 

51 recv sleep EcDsDdistGui 


stmgtdb1_TS1 

52 recv sleep EcDsDdistGui 


stmgtdb1_TS1 

53 recv sleep EcDsDdistGui 


stmgtdb1_TS1 

54 running stmgt_role 


stmgtdb1 


AWAITING COMMAND

0


AWAITING COMMAND

0


AWAITING COMMAND

0


AWAITING COMMAND

0


AWAITING COMMAND

x0icg01 0


SELECT

55 recv sleep EcDsStArchiveServer 0


stmgtdb1 AWAITING COMMAND

(55 rows affected)

(return status = 0)


7 Type sp_configure "user connections" at the 1> prompt then press Return/Enter. 

8 Type go at the 2> prompt then press Return/Enter. 

• A listing similar to the following one is displayed: 

Parameter Name Default Memory Used Config Value

Run Value


------------------------------ ----------- ----------- -----------­

----------­


number of user connections 25 20195 255

255


(1 row affected)

(return status = 0)


9 Type quit at the 1> prompt then press Return/Enter. 

10	 Compare the number of actual connections (results of sp_who) with the number of 
connections for which the database has been configured (results of sp_configure "user 
connections"). 

11	 If the number of actual connections is very close to the number of connections for which 
the database has been configured, notify the Database Administrator of the fact. 

12	 If the number of actual connections is not very close to the number of connections for 
which the database has been configured, compare the number of actual connections with 
the value for DBMaxConnections that the Database Administrator specified (Step 1). 

13	 If the number of actual connections is very close to the value for DBMaxConnections, 
notify the Database Administrator of the fact. 

•	 It may be advisable to increase the value assigned to the DBMaxConnections 
parameter in the Configuration Registry. 
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Practical Exercise


Introduction 

This exercise is designed to give the students practice in data distribution activities. 

Equipment and Materials 

One ECS workstation per student. 

Statement of the requirements for the exercise. 

Release 6A Operations Tools Manual for the ECS Project, 609-CD-600-001, one copy per 
student. 

Mission Operation Procedures for the ECS Project, 611-CD-600-001, one copy per student. 

Launching the Data Distribution Operator and Storage Management 
Control GUIs 

The exercise involves launching the Data Distribution Operator and Storage Management 
Control GUIs. The exercise begins with a student acting in the role of Ingest/Distribution 
Technician receiving the necessary information/ requirements for launching the Data 
Distribution Operator and Storage Management Control GUIs.  The student launches the data 
distribution and storage management control GUIs as specified in the requirements. 

Perform the following steps: 

1. Log in to the distribution server host using secure shell. 

2. Set the environmental variables. 

3. Enter the path to the utilities directory. 

4. Enter the command to start the Data Distribution Operator GUI in the specified mode. 

5. Enter the command to start the Storage Management Control GUI in the specified mode. 

Monitoring/Controlling Data Distribution Requests 

The exercise involves monitoring and controlling data distribution requests via ftp push or ftp 
pull. The exercise begins with a student acting in the role of Ingest/Distribution Technician 
receiving the necessary information/requirements for monitoring/controlling data distribution 
requests.  The requirements may include instructions to configure data distribution polling, filter 
data distribution requests, change the priority of a distribution request, or change the status of a 
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distribution request (e.g., cancel, suspend, or resume).  The student monitors/controls data 
distribution requests as specified in the requirements. 

Perform the following steps: 

1. Monitor/control data distribution requests as specified in the written or stated requirements. 

2. Configure data distribution polling as specified in the written or stated requirements. 

3. Filter requests as necessary. 

4. Change the status of distribution requests as specified in the written or stated requirements. 

5. Respond to questions concerning the current status of distribution requests. 

Modifying Preambles 

The exercise involves modifying an e-mail preamble applicable to data distribution.  The 
exercise begins with a student acting in the role of Ingest/Distribution Technician receiving the 
necessary information/requirements for modifying an e-mail preamble.  The student modifies the 
e-mail preamble in accordance with the requirements. 

Perform the following steps: 

1. Select the Preamble Editor tab of the Data Distribution Operator GUI. 

2. Select the appropriate media type. 

3. Select the appropriate preamble type. 

4. Edit the preamble text. 

5. Save the edited preamble. 

Configuring Storage Management Polling 

The exercise involves configuring Storage Management polling functions. The exercise begins 
with a student acting in the role of Ingest/Distribution Technician receiving the necessary 
information/requirements to configure Storage Management polling functions.  The student 
configures Storage Management polling functions as specified in the requirements. 

Perform the following steps: 

1.	 Select Options → System Settings from the pull-down menu on the Storage Management 
Control GUI. 

2.	 Set the Operator Notification Timer and/or Cache Statistics Timer to the appropriate 
polling states (off or on) if applicable. 

3.	 Enter the database polling rate for the Operator Notification Timer and/or Cache Statistics 
Timer if applicable. 

4. Set the error retry rate for the Operator Notification Timer if applicable. 
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5. Apply the modifications. 

Deleting Files from Cache 

The exercise involves deleting files from cache.  The exercise begins with a student acting in the 
role of Ingest/Distribution Technician receiving the necessary information/requirements to delete 
files from cache.  The student deletes files from cache as specified in the requirements. 

Perform the following steps: 

1. Select the Cache Stats. tab on the Storage Management Control GUI. 

2. Select the cache containing the files to be deleted. 

3. Select the file to be deleted from the cache. 

4. Click on the Mark Delete button. 

Viewing Storage Management Event Log Information 

The exercise involves viewing storage management event log information.  The exercise begins 
with a student acting in the role of Ingest/Distribution Technician receiving the necessary 
information/requirements for viewing storage management event log information. The student 
views storage management event log information as specified in the requirements. 

Perform the following steps: 

1. Select the Storage Events tab of the Storage Management Control GUI. 

2. Enter the defining characteristic(s) (e.g., time period, event type, event level) of the event. 

3. Click on the Search button to search the event log for events that meet the specified criteria. 

4. Observe event information displayed in the Event Log window. 

5.	 Respond to questions concerning the event information that is displayed in the Event Log 
window. 

Monitoring Storage Management Server Operations 

The exercise involves monitoring storage management server operations.  The exercise begins 
with a student acting in the role of Ingest/Distribution Technician receiving the necessary 
information/requirements for monitoring storage management server operations.  The 
requirements may include instructions to filter storage management requests. The student 
monitors storage management server operations as specified in the requirements. 

Perform the following steps: 

1.	 Monitor storage management server operations as specified in the written or stated 
requirements. 

2. Filter requests as necessary. 
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3. Respond to questions concerning the current status of requests. 

Modifying System Parameters 

The exercise involves modifying system parameters in database tables. The exercise begins with 
a student acting in the role of Ingest/Distribution Technician receiving the necessary 
information/ requirements for modifying system parameters in database tables.  The student 
modifies a system parameter in a database table as specified in the requirements. 

Perform the following steps: 

1. Access the command shell. 

2. Log in to the appropriate host using secure shell. 

3.	 Use the appropriate GUI, script, or isql commands to modify the value assigned to the 
parameter. 

Troubleshooting Data Distribution Problems 

The exercise involves troubleshooting data distribution problems.  The exercise begins with a 
student acting in the role of Ingest/Distribution Technician receiving the necessary trouble 
symptom information and requirements for troubleshooting the problem(s).  The student reviews 
the specified trouble symptoms, takes action to correct the problem(s), and responds to questions 
concerning the possible cause(s). 

Perform the following steps: 

1. Review the trouble symptoms. 

2. Respond to requests that exceed the distribution request threshold if applicable. 

3. Check for an acquire failure. 

4. Check appropriate log files as necessary. 

5. Take action to correct the problem(s). 

6. Verify that distribution request processing has resumed. 

7. Respond to questions concerning the possible cause(s) without error. 
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Slide Presentation


Slide Presentation Description 

The following slide presentation represents the slides used by the instructor during the conduct 
of this lesson. 
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